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Basic Safety Instructions

Always read through and comply with the following safety instructions!

All plants and locations of the Rohde & Schwarz group of companies make every effort to keep the safety
standards of our products up to date and to offer our customers the highest possible degree of safety. Our
products and the auxiliary equipment they require are designed, built and tested in accordance with the
safety standards that apply in each case. Compliance with these standards is continuously monitored by
our quality assurance system. The product described here has been designed, built and tested in
accordance with the attached EC Certificate of Conformity and has left the manufacturer’s plant in a
condition fully complying with safety standards. To maintain this condition and to ensure safe operation,
you must observe all instructions and warnings provided in this manual. If you have any questions
regarding these safety instructions, the Rohde & Schwarz group of companies will be happy to answer
them.

Furthermore, it is your responsibility to use the product in an appropriate manner. This product is designed
for use solely in industrial and laboratory environments or, if expressly permitted, also in the field and must
not be used in any way that may cause personal injury or property damage. You are responsible if the
product is used for any purpose other than its designated purpose or in disregard of the manufacturer's
instructions. The manufacturer shall assume no responsibility for such use of the product.

The product is used for its designated purpose if it is used in accordance with its product documentation
and within its performance limits (see data sheet, documentation, the following safety instructions). Using
the product requires technical skills and, in some cases, a basic knowledge of English. It is therefore
essential that only skilled and specialized staff or thoroughly trained personnel with the required skills be
allowed to use the product. If personal safety gear is required for using Rohde & Schwarz products, this
will be indicated at the appropriate place in the product documentation. Keep the basic safety instructions
and the product documentation in a safe place and pass them on to the subsequent users.

Observing the safety instructions will help prevent personal injury or damage of any kind caused by
dangerous situations. Therefore, carefully read through and adhere to the following safety instructions
before and when using the product. It is also absolutely essential to observe the additional safety
instructions on personal safety, for example, that appear in relevant parts of the product documentation. In
these safety instructions, the word "product” refers to all merchandise sold and distributed by the Rohde &
Schwarz group of companies, including instruments, systems and all accessories. For product-specific
information, see the data sheet and the product documentation.

Symbols and safety labels

Symbol Meaning Symbol Meaning

Notice, general danger location | O ON/OFF supply voltage

Observe product documentation

Caution when handling heavy equipment @ Standby indication

Danger of electric shock - Direct current (DC)

> B>
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Basic Safety Instructions

Meaning Symbol Meaning

Warning! Hot surface o Alternating current (AC)

Protective conductor terminal —~_ Direct/alternating current (DC/AC)

Ground I:l Device fully protected by double (reinforced)
insulation

Ground terminal EU labeling for batteries and accumulators

For additional information, see section "Waste
disposal/Environmental protection”, item 1.

Be careful when handling electrostatic sensitive
devices

EU labeling for separate collection of electrical
and electronic devices

For additonal information, see section "Waste
disposal/Environmental protection”, item 2.

Warning! Laser radiation

For additional information, see section
"Operation", item 7.

> b EEEp

Signal words and their meaning

The following signal words are used in the product documentation in order to warn the reader about risks
and dangers.

Indicates an imminently hazardous situation which, if not avoided, will result
A DANGER in death or serious injury.
Indicates a potentially hazardous situation which, if not avoided, could result
in death or serious injury.

A WARNING

Indicates a potentially hazardous situation which, if not avoided, could result
in minor or moderate injury.

Indicates the possibility of incorrect operation which can result in damage to
NOTICE the product.

In the product documentation, the word ATTENTION is used synonymously.

A CAUTION

These signal words are in accordance with the standard definition for civil applications in the European
Economic Area. Definitions that deviate from the standard definition may also exist in other economic
areas or military applications. It is therefore essential to make sure that the signal words described here
are always used only in connection with the related product documentation and the related product. The
use of signal words in connection with unrelated products or documentation can result in misinterpretation
and in personal injury or material damage.
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Basic Safety Instructions

Operating states and operating positions

The product may be operated only under the operating conditions and in the positions specified by the
manufacturer, without the product's ventilation being obstructed. If the manufacturer's specifications are
not observed, this can result in electric shock, fire and/or serious personal injury or death. Applicable local
or national safety regulations and rules for the prevention of accidents must be observed in all work
performed.

1.

Unless otherwise specified, the following requirements apply to Rohde & Schwarz products:
predefined operating position is always with the housing floor facing down, IP protection 2X, use only
indoors, max. operating altitude 2000 m above sea level, max. transport altitude 4500 m above sea
level. A tolerance of +10 % shall apply to the nominal voltage and +5 % to the nominal frequency,
overvoltage category 2, pollution severity 2.

Do not place the product on surfaces, vehicles, cabinets or tables that for reasons of weight or stability
are unsuitable for this purpose. Always follow the manufacturer's installation instructions when
installing the product and fastening it to objects or structures (e.g. walls and shelves). An installation
that is not carried out as described in the product documentation could result in personal injury or
even death.

Do not place the product on heat-generating devices such as radiators or fan heaters. The ambient
temperature must not exceed the maximum temperature specified in the product documentation or in
the data sheet. Product overheating can cause electric shock, fire and/or serious personal injury or
even death.

Electrical safety

If the information on electrical safety is not observed either at all or to the extent necessary, electric shock,
fire and/or serious personal injury or death may occur.

1.

Prior to switching on the product, always ensure that the nominal voltage setting on the product
matches the nominal voltage of the AC supply network. If a different voltage is to be set, the power
fuse of the product may have to be changed accordingly.

In the case of products of safety class | with movable power cord and connector, operation is
permitted only on sockets with a protective conductor contact and protective conductor.

Intentionally breaking the protective conductor either in the feed line or in the product itself is not
permitted. Doing so can result in the danger of an electric shock from the product. If extension cords
or connector strips are implemented, they must be checked on a regular basis to ensure that they are
safe to use.

If there is no power switch for disconnecting the product from the AC supply network, or if the power
switch is not suitable for this purpose, use the plug of the connecting cable to disconnect the product
from the AC supply network. In such cases, always ensure that the power plug is easily reachable and
accessible at all times. For example, if the power plug is the disconnecting device, the length of the
connecting cable must not exceed 3 m. Functional or electronic switches are not suitable for providing
disconnection from the AC supply network. If products without power switches are integrated into
racks or systems, the disconnecting device must be provided at the system level.

Never use the product if the power cable is damaged. Check the power cables on a regular basis to
ensure that they are in proper operating condition. By taking appropriate safety measures and
carefully laying the power cable, ensure that the cable cannot be damaged and that no one can be
hurt by, for example, tripping over the cable or suffering an electric shock.
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10.

1.

12.

13.

14.

15.

16.

17.

18.

Basic Safety Instructions

The product may be operated only from TN/TT supply networks fuse-protected with max. 16 A (higher
fuse only after consulting with the Rohde & Schwarz group of companies).

Do not insert the plug into sockets that are dusty or dirty. Insert the plug firmly and all the way into the
socket provided for this purpose. Otherwise, sparks that result in fire and/or injuries may occur.

Do not overload any sockets, extension cords or connector strips; doing so can cause fire or electric
shocks.

For measurements in circuits with voltages V,,s > 30 V, suitable measures (e.g. appropriate
measuring equipment, fuse protection, current limiting, electrical separation, insulation) should be
taken to avoid any hazards.

Ensure that the connections with information technology equipment, e.g. PCs or other industrial
computers, comply with the IEC60950-1/EN60950-1 or IEC61010-1/EN 61010-1 standards that apply
in each case.

Unless expressly permitted, never remove the cover or any part of the housing while the product is in
operation. Doing so will expose circuits and components and can lead to injuries, fire or damage to the
product.

If a product is to be permanently installed, the connection between the protective conductor terminal
on site and the product's protective conductor must be made first before any other connection is
made. The product may be installed and connected only by a licensed electrician.

For permanently installed equipment without built-in fuses, circuit breakers or similar protective
devices, the supply circuit must be fuse-protected in such a way that anyone who has access to the
product, as well as the product itself, is adequately protected from injury or damage.

Use suitable overvoltage protection to ensure that no overvoltage (such as that caused by a bolt of
lightning) can reach the product. Otherwise, the person operating the product will be exposed to the
danger of an electric shock.

Any object that is not designed to be placed in the openings of the housing must not be used for this
purpose. Doing so can cause short circuits inside the product and/or electric shocks, fire or injuries.

Unless specified otherwise, products are not liquid-proof (see also section "Operating states and
operating positions", item 1). Therefore, the equipment must be protected against penetration by
liquids. If the necessary precautions are not taken, the user may suffer electric shock or the product
itself may be damaged, which can also lead to personal injury.

Never use the product under conditions in which condensation has formed or can form in or on the
product, e.g. if the product has been moved from a cold to a warm environment. Penetration by water
increases the risk of electric shock.

Prior to cleaning the product, disconnect it completely from the power supply (e.g. AC supply network
or battery). Use a soft, non-linting cloth to clean the product. Never use chemical cleaning agents such
as alcohol, acetone or diluents for cellulose lacquers.

Operation

1.

Operating the products requires special training and intense concentration. Make sure that persons
who use the products are physically, mentally and emotionally fit enough to do so; otherwise, injuries
or material damage may occur. It is the responsibility of the employer/operator to select suitable
personnel for operating the products.
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Basic Safety Instructions

Before you move or transport the product, read and observe the section titled "Transport".

As with all industrially manufactured goods, the use of substances that induce an allergic reaction
(allergens) such as nickel cannot be generally excluded. If you develop an allergic reaction (such as a
skin rash, frequent sneezing, red eyes or respiratory difficulties) when using a Rohde & Schwarz
product, consult a physician immediately to determine the cause and to prevent health problems or
stress.

Before you start processing the product mechanically and/or thermally, or before you take it apart, be
sure to read and pay special attention to the section titled "Waste disposal/Environmental protection”,
item 1.

Depending on the function, certain products such as RF radio equipment can produce an elevated
level of electromagnetic radiation. Considering that unborn babies require increased protection,
pregnant women must be protected by appropriate measures. Persons with pacemakers may also be
exposed to risks from electromagnetic radiation. The employer/operator must evaluate workplaces
where there is a special risk of exposure to radiation and, if necessary, take measures to avert the
potential danger.

Should a fire occur, the product may release hazardous substances (gases, fluids, etc.) that can
cause health problems. Therefore, suitable measures must be taken, e.g. protective masks and
protective clothing must be worn.

Laser products are given warning labels that are standardized according to their laser class. Lasers
can cause biological harm due to the properties of their radiation and due to their extremely
concentrated electromagnetic power. If a laser product (e.g. a CD/DVD drive) is integrated into a
Rohde & Schwarz product, absolutely no other settings or functions may be used as described in the
product documentation. The objective is to prevent personal injury (e.g. due to laser beams).

EMC classes (in line with CISPR 11)

Class A: Equipment suitable for use in all environments except residential environments and
environments that are directly connected to a low-voltage supply network that supplies residential
buildings.

Class B: Equipment suitable for use in residential environments and environments that are directly
connected to a low-voltage supply network that supplies residential buildings.

Repair and service

1.

The product may be opened only by authorized, specially trained personnel. Before any work is
performed on the product or before the product is opened, it must be disconnected from the AC supply
network. Otherwise, personnel will be exposed to the risk of an electric shock.

Adjustments, replacement of parts, maintenance and repair may be performed only by electrical
experts authorized by Rohde & Schwarz. Only original parts may be used for replacing parts relevant
to safety (e.g. power switches, power transformers, fuses). A safety test must always be performed
after parts relevant to safety have been replaced (visual inspection, protective conductor test,
insulation resistance measurement, leakage current measurement, functional test). This helps ensure
the continued safety of the product.
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Basic Safety Instructions

Batteries and rechargeable batteries/cells

If the information regarding batteries and rechargeable batteries/cells is not observed either at all or to the
extent necessary, product users may be exposed to the risk of explosions, fire and/or serious personal
injury, and, in some cases, death. Batteries and rechargeable batteries with alkaline electrolytes (e.g.
lithium cells) must be handled in accordance with the EN 62133 standard.

1.
2.

Cells must not be taken apart or crushed.

Cells or batteries must not be exposed to heat or fire. Storage in direct sunlight must be avoided.
Keep cells and batteries clean and dry. Clean soiled connectors using a dry, clean cloth.

Cells or batteries must not be short-circuited. Cells or batteries must not be stored in a box or in a
drawer where they can short-circuit each other, or where they can be short-circuited by other
conductive materials. Cells and batteries must not be removed from their original packaging until they
are ready to be used.

Cells and batteries must not be exposed to any mechanical shocks that are stronger than permitted.

If a cell develops a leak, the fluid must not be allowed to come into contact with the skin or eyes. If
contact occurs, wash the affected area with plenty of water and seek medical aid.

Improperly replacing or charging cells or batteries that contain alkaline electrolytes (e.g. lithium cells)
can cause explosions. Replace cells or batteries only with the matching Rohde & Schwarz type (see
parts list) in order to ensure the safety of the product.

Cells and batteries must be recycled and kept separate from residual waste. Rechargeable batteries
and normal batteries that contain lead, mercury or cadmium are hazardous waste. Observe the
national regulations regarding waste disposal and recycling.

Transport

1.

The product may be very heavy. Therefore, the product must be handled with care. In some cases,
the user may require a suitable means of lifting or moving the product (e.g. with a lift-truck) to avoid
back or other physical injuries.

Handles on the products are designed exclusively to enable personnel to transport the product. It is
therefore not permissible to use handles to fasten the product to or on transport equipment such as
cranes, fork lifts, wagons, etc. The user is responsible for securely fastening the products to or on the
means of transport or lifting. Observe the safety regulations of the manufacturer of the means of
transport or lifting. Noncompliance can result in personal injury or material damage.

If you use the product in a vehicle, it is the sole responsibility of the driver to drive the vehicle safely
and properly. The manufacturer assumes no responsibility for accidents or collisions. Never use the
product in a moving vehicle if doing so could distract the driver of the vehicle. Adequately secure the
product in the vehicle to prevent injuries or other damage in the event of an accident.

Waste disposal/lEnvironmental protection

1.

Specially marked equipment has a battery or accumulator that must not be disposed of with unsorted
municipal waste, but must be collected separately. It may only be disposed of at a suitable collection
point or via a Rohde & Schwarz customer service center.
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Instrucciones de seguridad elementales

2. Waste electrical and electronic equipment must not be disposed of with unsorted municipal waste, but
must be collected separately.
Rohde & Schwarz GmbH & Co. KG has developed a disposal concept and takes full responsibility for
take-back obligations and disposal obligations for manufacturers within the EU. Contact your
Rohde & Schwarz customer service center for environmentally responsible disposal of the product.

3. If products or their components are mechanically and/or thermally processed in a manner that goes
beyond their intended use, hazardous substances (heavy-metal dust such as lead, beryllium, nickel)
may be released. For this reason, the product may only be disassembled by specially trained
personnel. Improper disassembly may be hazardous to your health. National waste disposal
regulations must be observed.

4. If handling the product releases hazardous substances or fuels that must be disposed of in a special
way, e.g. coolants or engine oils that must be replenished regularly, the safety instructions of the
manufacturer of the hazardous substances or fuels and the applicable regional waste disposal
regulations must be observed. Also observe the relevant safety instructions in the product
documentation. The improper disposal of hazardous substances or fuels can cause health problems
and lead to environmental damage.

For additional information about environmental protection, visit the Rohde & Schwarz website.

Instrucciones de seguridad elementales

iEs imprescindible leer y cumplir las siguientes instrucciones e informaciones de seguridad!

El principio del grupo de empresas Rohde & Schwarz consiste en tener nuestros productos siempre al dia
con los estandares de seguridad y de ofrecer a nuestros clientes el maximo grado de seguridad. Nuestros
productos y todos los equipos adicionales son siempre fabricados y examinados segun las normas de
seguridad vigentes. Nuestro sistema de garantia de calidad controla constantemente que sean cumplidas
estas normas. El presente producto ha sido fabricado y examinado segun el certificado de conformidad
adjunto de la UE y ha salido de nuestra planta en estado impecable segun los estdndares técnicos de
seguridad. Para poder preservar este estado y garantizar un funcionamiento libre de peligros, el usuario
debera atenerse a todas las indicaciones, informaciones de seguridad y notas de alerta. El grupo de
empresas Rohde & Schwarz esta siempre a su disposicion en caso de que tengan preguntas referentes a
estas informaciones de seguridad.

Ademas queda en la responsabilidad del usuario utilizar el producto en la forma debida. Este producto
estd destinado exclusivamente al uso en la industria y el laboratorio o, si ha sido expresamente
autorizado, para aplicaciones de campo y de ninguna manera debera ser utilizado de modo que alguna
persona/cosa pueda sufrir dafio. El uso del producto fuera de sus fines definidos o sin tener en cuenta las
instrucciones del fabricante queda en la responsabilidad del usuario. El fabricante no se hace en ninguna
forma responsable de consecuencias a causa del mal uso del producto.

1171.0000.42 - 06 Page 7



Instrucciones de seguridad elementales

Se parte del uso correcto del producto para los fines definidos si el producto es utilizado conforme a las
indicaciones de la correspondiente documentacion del producto y dentro del margen de rendimiento
definido (ver hoja de datos, documentacion, informaciones de seguridad que siguen). El uso del producto
hace necesarios conocimientos técnicos y ciertos conocimientos del idioma inglés. Por eso se debe tener
en cuenta que el producto solo pueda ser operado por personal especializado o personas instruidas en
profundidad con las capacidades correspondientes. Si fuera necesaria indumentaria de seguridad para el
uso de productos de Rohde & Schwarz, encontraria la informacion debida en la documentacion del
producto en el capitulo correspondiente. Guarde bien las informaciones de seguridad elementales, asi
como la documentacion del producto, y entréguelas a usuarios posteriores.

Tener en cuenta las informaciones de seguridad sirve para evitar en lo posible lesiones o dafios por
peligros de toda clase. Por eso es imprescindible leer detalladamente y comprender por completo las
siguientes informaciones de seguridad antes de usar el producto, y respetarlas durante el uso del
producto. Deberan tenerse en cuenta todas las demas informaciones de seguridad, como p. €j. las
referentes a la proteccién de personas, que encontraran en el capitulo correspondiente de la
documentacion del producto y que también son de obligado cumplimiento. En las presentes
informaciones de seguridad se recogen todos los objetos que distribuye el grupo de empresas

Rohde & Schwarz bajo la denominacién de "producto”, entre ellos también aparatos, instalaciones asi
como toda clase de accesorios. Los datos especificos del producto figuran en la hoja de datos y en la
documentacion del producto.

Simbolos y definiciones de seguridad

Simbolo

Significado

Simbolo

Significado

Aviso: punto de peligro general

Observar la documentacion del producto

| O

Tensién de alimentacion de PUESTA EN
MARCHA / PARADA

Atencion en el manejo de dispositivos de peso
elevado

Indicacion de estado de espera (standby)

Peligro de choque eléctrico

Corriente continua (DC)

Advertencia: superficie caliente

Corriente alterna (AC)

Conexién a conductor de proteccion

Corriente continua / Corriente alterna (DC/AC)

Conexion a tierra

El aparato esta protegido en su totalidad por un
aislamiento doble (reforzado)

EEE>>P>

Conexiéon a masa

Distintivo de la UE para baterias y
acumuladores

Mas informacién en la seccion
"Eliminacién/proteccion del medio ambiente”,
punto 1.
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Instrucciones de seguridad elementales

Simbolo Significado Simbolo Significado

Distintivo de la UE para la eliminacion por
separado de dispositivos eléctricos y
electrénicos

Aviso: Cuidado en el manejo de dispositivos
sensibles a la electrostatica (ESD)

Mas informacién en la seccion
"Eliminacion/proteccion del medio ambiente”,
punto 2.

Advertencia: rayo laser

Mas informacion en la seccion
"Funcionamiento”, punto 7.

Palabras de seiial y su significado

En la documentacioén del producto se utilizan las siguientes palabras de sefal con el fin de advertir contra
riesgos y peligros.

PELIGRO identifica un peligro inminente con riesgo elevado que
A PELIGRO provocara muerte o lesiones graves si no se evita.
ADVERTENCIA identifica un posible peligro con riesgo medio de
A ADVERTENCIA provocar muerte o lesiones (graves) si no se evita.

ATENCION identifica un peligro con riesgo reducido de provocar

A ATENCION lesiones leves o0 moderadas si no se evita.
AVISO indica la posibilidad de utilizar mal el producto y, como
m consecuencia, danarlo.

En la documentacién del producto se emplea de forma sinénima el
término CUIDADO.

Las palabras de sefal corresponden a la definicion habitual para aplicaciones civiles en el area
economica europea. Pueden existir definiciones diferentes a esta definicidn en otras areas econémicas o
en aplicaciones militares. Por eso se debera tener en cuenta que las palabras de sefal aqui descritas
sean utilizadas siempre solamente en combinacién con la correspondiente documentacion del producto y
solamente en combinacién con el producto correspondiente. La utilizacion de las palabras de sefial en
combinacion con productos o documentaciones que no les correspondan puede llevar a interpretaciones
equivocadas Yy tener por consecuencia dafios en personas u objetos.

Estados operativos y posiciones de funcionamiento

El producto solamente debe ser utilizado segutn lo indicado por el fabricante respecto a los estados
operativos y posiciones de funcionamiento sin que se obstruya la ventilacion. Si no se siguen las
indicaciones del fabricante, pueden producirse choques eléctricos, incendios y/o lesiones graves con
posible consecuencia de muerte. En todos los trabajos deberan ser tenidas en cuenta las normas
nacionales y locales de seguridad del trabajo y de prevencion de accidentes.
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Instrucciones de seguridad elementales

Si no se convino de otra manera, es para los productos Rohde & Schwarz valido lo que sigue:
como posicion de funcionamiento se define por principio la posicién con el suelo de la caja para
abajo, modo de proteccion IP 2X, uso solamente en estancias interiores, utilizacion hasta 2000 m
sobre el nivel del mar, transporte hasta 4500 m sobre el nivel del mar. Se aplicara una tolerancia de
+10 % sobre el voltaje nominal y de +5 % sobre la frecuencia nominal. Categoria de sobrecarga
eléctrica 2, indice de suciedad 2.

No situe el producto encima de superficies, vehiculos, estantes 0 mesas, que por sus caracteristicas
de peso o de estabilidad no sean aptos para él. Siga siempre las instrucciones de instalacién del
fabricante cuando instale y asegure el producto en objetos o estructuras (p. ej. paredes y estantes). Si
se realiza la instalacion de modo distinto al indicado en la documentacién del producto, se pueden
causar lesiones o, en determinadas circunstancias, incluso la muerte.

No ponga el producto sobre aparatos que generen calor (p. ej. radiadores o calefactores). La
temperatura ambiente no debe superar la temperatura maxima especificada en la documentacion del
producto o en la hoja de datos. En caso de sobrecalentamiento del producto, pueden producirse
choques eléctricos, incendios y/o lesiones graves con posible consecuencia de muerte.

Seguridad eléctrica

Si no se siguen (o se siguen de modo insuficiente) las indicaciones del fabricante en cuanto a seguridad
eléctrica, pueden producirse choques eléctricos, incendios y/o lesiones graves con posible consecuencia
de muerte.

1.

Antes de la puesta en marcha del producto se debera comprobar siempre que la tensién
preseleccionada en el producto coincida con la de la red de alimentacion eléctrica. Si es necesario
modificar el ajuste de tension, también se deberan cambiar en caso dado los fusibles
correspondientes del producto.

Los productos de la clase de proteccién | con alimentacion maévil y enchufe individual solamente
podran enchufarse a tomas de corriente con contacto de seguridad y con conductor de proteccion
conectado.

Queda prohibida la interrupcion intencionada del conductor de proteccion, tanto en la toma de
corriente como en el mismo producto. La interrupcién puede tener como consecuencia el riesgo de
que el producto sea fuente de choques eléctricos. Si se utilizan cables alargadores o regletas de
enchufe, debera garantizarse la realizacion de un examen regular de los mismos en cuanto a su
estado técnico de seguridad.

Si el producto no esta equipado con un interruptor para desconectarlo de la red, o bien si el
interruptor existente no resulta apropiado para la desconexion de la red, el enchufe del cable de
conexion se debera considerar como un dispositivo de desconexion.

El dispositivo de desconexién se debe poder alcanzar facilmente y debe estar siempre bien accesible.
Si, p. €j., el enchufe de conexion a la red es el dispositivo de desconexion, la longitud del cable de
conexion no debe superar 3 m).

Los interruptores selectores o electronicos no son aptos para el corte de la red eléctrica. Si se
integran productos sin interruptor en bastidores o instalaciones, se debera colocar el interruptor en el
nivel de la instalacion.

No utilice nunca el producto si esta dafiado el cable de conexién a red. Compruebe regularmente el
correcto estado de los cables de conexion a red. Asegurese, mediante las medidas de proteccion y
de instalacién adecuadas, de que el cable de conexion a red no pueda ser dafiado o de que nadie
pueda ser danado por él, p. €j. al tropezar o por un choque eléctrico.
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10.

1.

12.

13.

14.

15.

16.

17.

18.

Instrucciones de seguridad elementales

Solamente esta permitido el funcionamiento en redes de alimentacion TN/TT aseguradas con fusibles
de 16 A como maximo (utilizaciéon de fusibles de mayor amperaje solo previa consulta con el grupo de
empresas Rohde & Schwarz).

Nunca conecte el enchufe en tomas de corriente sucias o llenas de polvo. Introduzca el enchufe por
completo y fuertemente en la toma de corriente. La no observacion de estas medidas puede provocar
chispas, fuego y/o lesiones.

No sobrecargue las tomas de corriente, los cables alargadores o las regletas de enchufe ya que esto
podria causar fuego o choques eléctricos.

En las mediciones en circuitos de corriente con una tensién Uy > 30 V se deberan tomar las medidas
apropiadas para impedir cualquier peligro (p. ej. medios de medicién adecuados, seguros, limitacién
de tension, corte protector, aislamiento etc.).

Para la conexién con dispositivos informaticos como un PC o un ordenador industrial, debe
comprobarse que éstos cumplan los estandares IEC60950-1/EN60950-1 o IEC61010-1/EN 61010-1
validos en cada caso.

A menos que esté permitido expresamente, no retire nunca la tapa ni componentes de la carcasa
mientras el producto esté en servicio. Esto pone a descubierto los cables y componentes eléctricos y
puede causar lesiones, fuego o dafios en el producto.

Si un producto se instala en un lugar fijo, se debera primero conectar el conductor de proteccion fijo
con el conductor de proteccion del producto antes de hacer cualquier otra conexion. La instalacién y
la conexion deberan ser efectuadas por un electricista especializado.

En el caso de dispositivos fijos que no estén provistos de fusibles, interruptor automatico ni otros
mecanismos de seguridad similares, el circuito de alimentacién debe estar protegido de modo que
todas las personas que puedan acceder al producto, asi como el producto mismo, estén a salvo de
posibles dafnos.

Todo producto debe estar protegido contra sobretension (debida p. ej. a una caida del rayo) mediante
los correspondientes sistemas de proteccion. Si no, el personal que lo utilice quedara expuesto al
peligro de choque eléctrico.

No debe introducirse en los orificios de la caja del aparato ningun objeto que no esté destinado a ello.
Esto puede producir cortocircuitos en el producto y/o puede causar choques eléctricos, fuego o
lesiones.

Salvo indicacion contraria, los productos no estan impermeabilizados (ver también el capitulo
"Estados operativos y posiciones de funcionamiento", punto 1). Por eso es necesario tomar las
medidas necesarias para evitar la entrada de liquidos. En caso contrario, existe peligro de choque
eléctrico para el usuario o de dafios en el producto, que también pueden redundar en peligro para las
personas.

No utilice el producto en condiciones en las que pueda producirse o ya se hayan producido
condensaciones sobre el producto o en el interior de éste, como p. €j. al desplazarlo de un lugar frio a
otro caliente. La entrada de agua aumenta el riesgo de choque eléctrico.

Antes de la limpieza, desconecte por completo el producto de la alimentacion de tension (p. ej. red de
alimentacion o bateria). Realice la limpieza de los aparatos con un pafio suave, que no se deshilache.
No utilice bajo ningun concepto productos de limpieza quimicos como alcohol, acetona o diluyentes
para lacas nitroceluldsicas.
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Instrucciones de seguridad elementales

Funcionamiento

1.

El uso del producto requiere instrucciones especiales y una alta concentracién durante el manejo.
Debe asegurarse que las personas que manejen el producto estén a la altura de los requerimientos
necesarios en cuanto a aptitudes fisicas, psiquicas y emocionales, ya que de otra manera no se
pueden excluir lesiones o dafios de objetos. El empresario u operador es responsable de seleccionar
el personal usuario apto para el manejo del producto.

Antes de desplazar o transportar el producto, lea y tenga en cuenta el capitulo "Transporte".

Como con todo producto de fabricacion industrial no puede quedar excluida en general la posibilidad
de que se produzcan alergias provocadas por algunos materiales empleados —los llamados
alérgenos (p. €j. el niquel)—. Si durante el manejo de productos Rohde & Schwarz se producen
reacciones alérgicas, como p. €j. irritaciones cutaneas, estornudos continuos, enrojecimiento de la
conjuntiva o dificultades respiratorias, debe avisarse inmediatamente a un médico para investigar las
causas Y evitar cualquier molestia o dafio a la salud.

Antes de la manipulacién mecénica y/o térmica o el desmontaje del producto, debe tenerse en cuenta
imprescindiblemente el capitulo "Eliminacion/proteccion del medio ambiente", punto 1.

Ciertos productos, como p. €j. las instalaciones de radiocomunicacion RF, pueden a causa de su
funcion natural, emitir una radiacion electromagnética aumentada. Deben tomarse todas las medidas
necesarias para la proteccion de las mujeres embarazadas. También las personas con marcapasos
pueden correr peligro a causa de la radiacién electromagnética. El empresario/operador tiene la
obligacién de evaluar y sefializar las areas de trabajo en las que exista un riesgo elevado de
exposicion a radiaciones.

Tenga en cuenta que en caso de incendio pueden desprenderse del producto sustancias téxicas
(gases, liquidos etc.) que pueden generar dafos a la salud. Por eso, en caso de incendio deben
usarse medidas adecuadas, como p. ej. mascaras antigas e indumentaria de proteccion.

Los productos con laser estan provistos de indicaciones de advertencia normalizadas en funcion de la
clase de laser del que se trate. Los rayos laser pueden provocar dafios de tipo bioldgico a causa de
las propiedades de su radiacion y debido a su concentracion extrema de potencia electromagnética.
En caso de que un producto Rohde & Schwarz contenga un producto laser (p. €j. un lector de
CD/DVD), no debe usarse ninguna otra configuracion o funcién aparte de las descritas en la
documentacion del producto, a fin de evitar lesiones (p. €j. debidas a irradiacion laser).

Clases CEM (segun CISPR 11)

Clase A: dispositivo apropiado para el uso en cualquier zona excepto en areas residenciales y en
aquellas zonas que se encuentran conectadas a una red de suministro de baja tensién que alimenta
un edificio de viviendas.

Clase B: dispositivo apropiado para el uso en areas residenciales y en aquellas zonas que se
encuentran conectadas a una red de suministro de baja tensiéon que alimenta un edificio de viviendas.

Reparaciéon y mantenimiento

1.

El producto solamente debe ser abierto por personal especializado con autorizacion para ello. Antes
de manipular el producto o abrirlo, es obligatorio desconectarlo de la tension de alimentacion, para
evitar toda posibilidad de choque eléctrico.
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2.

Instrucciones de seguridad elementales

El ajuste, el cambio de partes, el mantenimiento y la reparaciéon deberan ser efectuadas solamente
por electricistas autorizados por Rohde & Schwarz. Si se reponen partes con importancia para los
aspectos de seguridad (p. €j. el enchufe, los transformadores o los fusibles), solamente podran ser
sustituidos por partes originales. Después de cada cambio de partes relevantes para la seguridad
debera realizarse un control de seguridad (control a primera vista, control del conductor de
proteccion, medicion de resistencia de aislamiento, medicién de la corriente de fuga, control de
funcionamiento). Con esto queda garantizada la seguridad del producto.

Baterias y acumuladores o celdas

Si no se siguen (o se siguen de modo insuficiente) las indicaciones en cuanto a las baterias y
acumuladores o celdas, pueden producirse explosiones, incendios y/o lesiones graves con posible
consecuencia de muerte. El manejo de baterias y acumuladores con electrolitos alcalinos (p. ej. celdas de
litio) debe seguir el estandar EN 62133.

1.
2.

No deben desmontarse, abrirse ni triturarse las celdas.

Las celdas o baterias no deben someterse a calor ni fuego. Debe evitarse el almacenamiento a la luz
directa del sol. Las celdas y baterias deben mantenerse limpias y secas. Limpiar las conexiones
sucias con un pafo seco Yy limpio.

Las celdas o baterias no deben cortocircuitarse. Es peligroso almacenar las celdas o baterias en
estuches o cajones en cuyo interior puedan cortocircuitarse por contacto reciproco o por contacto con
otros materiales conductores. No deben extraerse las celdas o baterias de sus embalajes originales
hasta el momento en que vayan a utilizarse.

Las celdas o baterias no deben someterse a impactos mecanicos fuertes indebidos.

En caso de falta de estanqueidad de una celda, el liquido vertido no debe entrar en contacto con la
piel ni los ojos. Si se produce contacto, lavar con agua abundante la zona afectada y avisar a un
médico.

En caso de cambio o recarga inadecuados, las celdas o baterias que contienen electrolitos alcalinos
(p. €j. las celdas de litio) pueden explotar. Para garantizar la seguridad del producto, las celdas o
baterias solo deben ser sustituidas por el tipo Rohde & Schwarz correspondiente (ver lista de
recambios).

Las baterias y celdas deben reciclarse y no deben tirarse a la basura doméstica. Las baterias o
acumuladores que contienen plomo, mercurio o cadmio deben tratarse como residuos especiales.
Respete en esta relacién las normas nacionales de eliminacion y reciclaje.

Transporte

1.

El producto puede tener un peso elevado. Por eso es necesario desplazarlo o transportarlo con
precaucion y, si es necesario, usando un sistema de elevaciéon adecuado (p. ej. una carretilla
elevadora), a fin de evitar lesiones en la espalda u otros dafios personales.

Las asas instaladas en los productos sirven solamente de ayuda para el transporte del producto por
personas. Por eso no esta permitido utilizar las asas para la sujecion en o sobre medios de transporte
como p. ej. gruas, carretillas elevadoras de horquilla, carros etc. Es responsabilidad suya fijar los
productos de manera segura a los medios de transporte o elevacion. Para evitar dafos personales o
dafios en el producto, siga las instrucciones de seguridad del fabricante del medio de transporte o
elevacién utilizado.

1171.0000.42 - 06 Page 13



Instrucciones de seguridad elementales

Si se utiliza el producto dentro de un vehiculo, recae de manera exclusiva en el conductor la
responsabilidad de conducir el vehiculo de manera segura y adecuada. El fabricante no asumira
ninguna responsabilidad por accidentes o colisiones. No utilice nunca el producto dentro de un
vehiculo en movimiento si esto pudiera distraer al conductor. Asegure el producto dentro del vehiculo
debidamente para evitar, en caso de un accidente, lesiones u otra clase de dafios.

Eliminacion/proteccion del medio ambiente

1.

Los dispositivos marcados contienen una bateria o un acumulador que no se debe desechar con los
residuos domésticos sin clasificar, sino que debe ser recogido por separado. La eliminacién se debe
efectuar exclusivamente a través de un punto de recogida apropiado o del servicio de atencion al
cliente de Rohde & Schwarz.

Los dispositivos eléctricos usados no se deben desechar con los residuos domésticos sin clasificar,
sino que deben ser recogidos por separado.

Rohde & Schwarz GmbH & Co.KG ha elaborado un concepto de eliminacion de residuos y asume
plenamente los deberes de recogida y eliminacién para los fabricantes dentro de la UE. Para
desechar el producto de manera respetuosa con el medio ambiente, dirijase a su servicio de atencién
al cliente de Rohde & Schwarz.

Si se trabaja de manera mecanica y/o térmica cualquier producto o componente mas alla del
funcionamiento previsto, pueden liberarse sustancias peligrosas (polvos con contenido de metales
pesados como p. ej. plomo, berilio o niquel). Por eso el producto solo debe ser desmontado por
personal especializado con formacion adecuada. Un desmontaje inadecuado puede ocasionar dafios
para la salud. Se deben tener en cuenta las directivas nacionales referentes a la eliminacién de
residuos.

En caso de que durante el trato del producto se formen sustancias peligrosas o combustibles que
deban tratarse como residuos especiales (p. €j. refrigerantes o aceites de motor con intervalos de
cambio definidos), deben tenerse en cuenta las indicaciones de seguridad del fabricante de dichas
sustancias y las normas regionales de eliminacién de residuos. Tenga en cuenta también en caso
necesario las indicaciones de seguridad especiales contenidas en la documentacién del producto. La
eliminacion incorrecta de sustancias peligrosas o combustibles puede causar dafios a la salud o
dafios al medio ambiente.

Se puede encontrar mas informacion sobre la proteccién del medio ambiente en la pagina web de
Rohde & Schwarz.
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Qualitatszertifikat
Certificate of quality
Certificat de qualité

Sehr geehrter Kunde,

Sie haben sich fur den Kauf eines
Rohde & Schwarz-Produktes ent-
schieden. Hiermit erhalten Sie ein
nach modernsten Fertigungsmethoden
hergestelltes Produkt. Es wurde nach
den Regeln unseres Qualitatsmanage-
mentsystems entwickelt, gefertigt
und gepruft. Das Rohde &Schwarz-
Qualitadtsmanagementsystem ist u.a.
nach ISO9001 und ISO 14001
zertifiziert.

Der Umwvelt verpflichtet

1 Energie-effiziente,
RoHS-konforme Produkte

1 Kontinuierliche Weiterentwicklung
nachhaltiger Umweltkonzepte

1 1ISO 14001-zertifiziertes
Umweltmanagementsystem

Dear Customer,

You have decided to buy a
Rohde & Schwarz product. You are
thus assured of receiving a product
that is manufactured using the most
modern methods available. This
product was developed, manufactured
and tested in compliance with our
quality management system stan-
dards. The Rohde & Schwarz quality
management system is certified
according to standards such as
ISO9001 and ISO 14001.

Environmental commitment

1 Energy-efficient products

1 Continuous improvement in
environmental sustainability

11SO 14001-certified environmental
management system

Certified Quality System

IS0 9001

Certified Environmental System

1S0 14001

Cher client,

Vous avez choisi d'acheter un pro-
duit Rohde & Schwarz. Vous disposez
donc d'un produit fabriqué d'apreés les
méthodes les plus avancées. Le déve-
loppement, la fabrication et les tests
respectent nos normes de gestion
qualité. Le systeme de gestion qualité
de Rohde &Schwarz a été homologué,
entre autres, conformément aux nor-
mes ISO9001 et ISO 14001.

Engagement écologique

1 Produits a efficience énergétique

1 Amélioration continue de la durabilité
environnementale

1 Systeme de gestion de I'environne-
ment certifié selon ISO 14001
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Customer Support

Technical support — where and when you need it

For quick, expert help with any Rohde & Schwarz equipment, contact one of our Customer Support
Centers. A team of highly qualified engineers provides telephone support and will work with you to find a
solution to your query on any aspect of the operation, programming or applications of Rohde & Schwarz
equipment.

Up-to-date information and upgrades

To keep your instrument up-to-date and to be informed about new application notes related to your
instrument, please send an e-mail to the Customer Support Center stating your instrument and your wish.
We will take care that you will get the right information.

Europe, Africa, Middle East Phone +49 89 4129 12345
customersupport@rohde-schwarz.com

North America Phone 1-888-TEST-RSA (1-888-837-8772)
customer.support@rsa.rohde-schwarz.com

Latin America Phone +1-410-910-7988
customersupport.la@rohde-schwarz.com

Asia/Pacific Phone +6565 1304 88
customersupport.asia@rohde-schwarz.com

China Phone +86-800-810-8228 /
+86-400-650-5896
customersupport.china@rohde-schwarz.com

ROHDE&SCHWARZ

1171.0200.22-06.00
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1 Overview

1402.0043.12

Acoustic Measurements on Mobile Phones

The acoustic transmission and reproduction quality of a mobile phone is
its most important characteristic in everyday use. Even the most visually
appealing design and wonderfully sophisticated operating concept are not
much use, when the user cannot or can hardly understand what is being
said at the other end.

Instruments and methods for measuring acoustic characteristics are therefore
essential tools for assessing the quality and suitability of a mobile phone.

Since a digital audio interface is no longer required even for conformance
tests on 3rd generation mobile phones, it was necessary to develop new test
methods that allowed measurements to be performed via the air interface and
the normal speech coder and decoder. The test signals have to simulate
human voice in the frequency and time domain to be able to test the mobile
phone in the normal operating mode with DSP assessment such as voice
activity detector (VAD), noise suppression, echo cancellation, etc switched
on.

These tests are based on standards for 3GPP mobile phones. The test
methods are stipulated in 3GPP TS 26.132 and the values to be attained in
3GPP TS 26.131.

As of release 4 of the GSM 51.010 standard (successor to GSM 11.10), even
GSM mobile phones may be tested to 3GPP TS 26.132.

The R&S UPV-K9 and R&S UPV-K91 options (UMTS/GSM Mobile Phone
Tests) of the Audio Analyzer R&S UPV, called herein below “UPV”, are now
available for measuring the acoustic characteristics of UMTS and GSM
mobile phones. The measurements are in line with 3GPP TS 26.131, TS
26.132 and TS 51.010 and have been validated by an independent test house
for conformance testing on UMTS and GSM maobile phones.

The current version of the software supports 3GPP TS 26.131 and TS 26.132
up to Release 10.

From version 2.3.1.47 of the software, a new “Release” menu is available
which allows to determine and start the test cases applicable to a given
combination of speech codec bandwidth, type of tested device (handset,
headset or handheld, desktop or vehicle-mounted handsfree) and release
number of the test specifications.



2 Preparation and Start of the Application Software

Acoustic Measurements on Mobile Phones

Required Measuring Instruments and Accessories

The Audio Analyzer R&S UPV with the following options is required for the

measurements:

¢ R&S UPV-K9 Base Software for Mobile Phone Tests
e R&S UPV-K91 UMTS/GSM Mobile Phone Tests
o R&S UPV-K9102 Upgrade 02 to R&S UPV-K91

The GSM mobile phone under test is connected via the RF interface
using the Universal Digital Radio Communication Tester R&S CMU200,
called herein below R&S CMU200. This tester simulates a base station
for the mobile phone so that a call can be set up. For GSM, the
R&S CMU200 must be equipped with the options R&S CMU-B21
(signalling unit), R&S CMU-B52 (speech coder/decoder) and the
appropriate software options for the GSM band used. For WCDMA
(UMTS), the option R&S CMU-B69 is required. Wideband-AMR tests
require option R&S CMU-K46 for both GSM and/or WCDMA (UMTS).

Note: The firmware version in the R&S CMU200 must be 5.04 or

higher.

Acoustic devices such as an artificial mouth, artificial ear and other
accessories are required for the measurements.
equipment from Briel & Kjeer or G.R.A.S. is normally used:

Table 1

Device

Equipment for mobile phone tests

Description

The following

Type (examples)

Telephone test head
(up to Release 8)

Device for fixing the DUT in the
prescribed position

B&K 4602B

Wideband ear simulator
(up to Release 8)

IEC 711 type occluded ear simulator
with adapters for connection to the
ear piece of the DUT

B&K 4195 (type 3.2)

Artificial mouth
(up to Release 8)

Special loudspeaker for simulation
of the mouth

B&K 4227 or

G.R.A.S. 44AB or
44AA (with power

amplifier)
Head and torso simulator Head and torso simulator with B&K 4128 D
artificial ear (type 3.3) and artificial
mouth, may be used alternatively to
the abovementioned devices
Handset fixture for Head Required to position the handset on B&K 4606

and Torso simulator

the artificial head, and to apply a
defined force with the earpiece
against the pinna

Measurement microphone

2" or ¥a” measurement microphone

B&K 4191 (free

for measurement of artificial mouth field, may be used
output during calibration. This for hands free tests),
microphone can use the preamplifier | B&K 4192 (pressure
of the artificial ear type 3.2 if field, may be used
existing. Use a 2" measurement with type 1 art. ear)
microphone for calibration of the
HATS mouth.

Acoustic calibrator Sound level calibrator for calibrating | B&K 4231

the measuring microphone

B&K 2829, 5935L or
2690A0S2

or G.R.A.S. 12AD or
12AA

Microphone power supply Power supply and preamplifier for

the measuring microphone

1402.0043.12 8 E-6
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Note: With the amplifier set to 0 dB, the microphone power supply
B&K 2690A0S2 produces too much noise for measuring idle
noise and distortion. It is therefore advisable to set a gain of
20 dB.

From Release 9 of TS 26132, the use of the HATS is mandatory for
handset and headset measurements. From Release 10, only artificial
ear type 3.3 (anatomically shaped soft pinna) may be used.

A cable with a BNC connector and special small or angled banana
plugs is required for connecting the artificial mouth, as the space
between the mouth connectors and the LRGP test head (B&K 4602B) is
too small for common banana plugs.

The transformer supplied with option R&S UPV-K9 must be connected
between generator output 1 of Audio Analyzer R&S UPV and the
connector of the artificial mouth. The transformer matches the
impedance of the loudspeaker in the artificial mouth to that of the
generator output of the R&S UPV. Without this transformer, the
available power is too low for driving the artificial mouth.

Alternatively, a power amplifier, preferably with a voltage gain of approx.
0 dB, can be connected between generator output and mouth instead of
the transformer. In this case, the gain set must be kept absolutely stable
after calibration. For tests using artificial voice according to ITU-T P.50,
a power amplifier is required. It may also be required for high-level
activation signals with high crest factor.

A cable with male (analyzer) and female (generator) XLR connector is
supplied for connection to the "Speech" connector of the Digital Radio
Communication Tester R&S CMU200.

UPV Analyzer Generator

Fig. 1 Assignment of 9-contact speech connector on CMU front
panel

This cable is configured for connection to link handler #1 in the

R&S CMU200. Depending on the CMU hardware, link handler #2 in the
R&S CMU200 can also be used for GSM; in this case, the supplied
adapter must be inserted between the cable and the speech connector
on the R&S CMU200.

Note: If the CODEC calibration fails, the adapter has most likely to
be inserted.
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Note: The R&S CMUZ200 connects pin 1 of the R&S UPV
generator output to the equipment grounding conductor of
the mains. If an external power amplifier is used, care must
be taken that the external power amplifier does not connect
R&S UPV generator output pin 2 to the equipment grounding
conductor of the mains. If available, a balanced connection
to the power amplifier should be preferred.

Attention: An external power amplifier should be switched on after the
R&S UPV-K9x program has been started, and switched off
before the program is ended. This prevents the artificial
mouth from undue power loading by setups which are
loaded external to the application.

Note: An external USB keyboard and a mouse must be connected
to the R&S UPV.

Caution: R&S UPV-K9x does not support the use of headphones. Do
not connect headphones to the R&S UPV during mobile
phone tests. High level signals may be present at the
headphone connector.

The audio analyzer must meet the following firmware requirements:
e R&S UPV firmware version 3.3.0.724 or higher

o License Key R&S UPV-K9 installed

¢ License Key R&S UPV-K91 installed.

o For use of test signal according to ITU-T P.50 and distortion tests with
CSS or customer specific activation signal License Key R&S UPV-
K9101 or higher must be installed.

o For the use of new requirements and test methods according to Release
10 of TS 26.131 and TS 26.132, License Key R&S UPV-K9102 must be
installed.

e License Key R&S UPV-K9102 includes R&S UPV-K9101

Installing the Software

The application program requires option keys K9 and K91 to be
installed. The application program and the keys are installed together
with key K9102 in the factory in case a new R&S UPV is ordered
together with these options. If the options are ordered separately, the
keys as well as the installation manual are part of the delivery.

The program required and the associated files are in the folder “UPV-
K9x Software” on the installation CD supplied with the R&S UPV-K91
option. It is recommended to copy the files MCRInstaller.exe,
RsVisaTarget.msi, UPV-K9x_23147.msi, Config.ini, dotnetfx.exe,
Setup.exe and Settings.ini from the folder “UPV-K9x Software” on the
installation CD to drive D: on the R&S UPV hard disk drive, e.g. to a
folder named “D:\R&S Software\UPV-K9x\Version 2.3.1”. Run the file
“Setup.exe” to start the installation. Follow the instructions of the
installer on the screen. Subsequently, run also “MCRInstaller.exe” and
“‘RsVisaTarget.msi”. If the software UPV-K9y for option R&S UPV-K92
or the previous version 2.2.1.43 of R&S UPV-K9x is installed on the
R&S UPV, the Matlab runtime is already installed, and MCRInstaller
does not have to be run.

Attention: Once installed, the R&S Visa must not be uninstalled.

To have full control over minimized windows, it is recommended to set
the windows taskbar to “Auto-hide”, on top of other windows. Right-click
on the Windows Start button and click “properties”.

10 E-6
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Open
Explare
Search...
Properties

Cpen Al Users
Explare &ll Users

E’BSl:aTtl J 5.. L= ﬁ

Fig.2  Context menu for taskbar

In the properties window, click tab “Taskbar” and activate “Auto-hide the
taskbar” and “Keep the taskbar on top of other windows”. Click “Apply”
and close the window.

Taskbar and Start Menu Properties E |

Taskbar | Start Menu I

— T askbar appearance

[ Lock the taskbar
V¥ Aute-hide the taskbar
¥ Eeep the taskbar on top of ather windows

¥ Group similar taskbar buttons
¥ Show Quick Launch

— Matification area

() 1:23 PM

¥ Show the clock

'ou can keep the natification area uncluttered by hiding icohs that you
have not clicked recently.

¥ Hide inactive icons Customize. . |

Fig. 3  Properties window for taskbar

Verification of the Installation

After the installation, check the existence of the subfolder “UPV-K9x
Mobile Phone Tests” in “C:\Program Files\Rohde&Schwarz’. This
subfolder must contain 82 files plus 2 more subfolders.

If the software reports a missing key code at the first start, delete folder
“‘D:\3GPP” (if existing) and install the missing key code before starting
the software again.

11 E-6
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Test Setup

| o e -
5 - Microphone
-’e Supply
9 0O O a
f,’ art ear

| f:‘iw ) ey e e e

i 8
(D LK
art mouth

[] (]
= ]
] ]
= ]
] ]
] ]
a ]
] ]
a ]
(e e e e e s e

u

RF to Mobile

Fig. 4  Test setup and connection of external components

For measurements using artificial voice according to ITU-T P.50, for
distortion tests using a composite source signal (CSS) as activation
signal and for delay tests with CSS as test signal, the transformer
supplied with option R&S UPV-K9 has to be replaced by a (not
supplied) external power amplifier. The power amplifier should have a
moderate but stable gain between 0 dB and 20 dB and a moderate
maximum output power between 5 W and 20 W. It is essential that the
gain is not changed between mouth calibration and sending tests.

3GPP TS 26.132 specifies binaural measurement for the test of
Handsfree (speakerphone) devices using a head-and torso simulator
(HATS). From Release 8, binaural measurement is also foreseen for
binaural headsets. The HATS 4128 supplied by Bruel & Kjaer offers an
optional left ear simulator 4159C for binaural measurements. The
second ear simulator has to be connected to R&S UPV analyzer input 2
for binaural receiving measurements. As this input is also used to
connect to the R&SCMU200 decoder output for sending
measurements, R&S 3GPP Mobile Phone Tests R&S UPV-K91 support
automatic control of an input switcher R&S UPZ. The connection for
automatic input switching is done as shown in Fig. 5.

12 E-6



1402.0043.12

Acoustic Measurements on Mobile Phones

Power Supply

Power Supply

Amplifier or -

Transformer

RF Connection ” ‘

Fig.5 Test setup and connection of external components for
automatic switching

Starting the Application Software

After installation, the program can be started by double-clicking the Icon
“UPV-K9x Mobile Phone Tests” or by clicking “R&S UPV Applications >
UPV-K9x Mobile Phone Tests” in the “Programs” menu.

At the fist start of the program, selection windows appear for the
standard according to which the measurements should be made, and
for the artificial ear and artificial mouth used.

@ Standard =]

Please select a standard below:

AGPP Hand5 Marron

[ Allow only selected measurements

Cancel | Ok I
Y

o

Fig. 6  Query window for selection of applied standard

If “none” is selected in the standard selection window, all
measurements appear in the “Measurement” menu. If a standard is
selected, all measurements appear in the “Measurement” menu, but
compliant measurements are checked in the menu. If “Allow only
selected measurements” is checked, non-compliant measurements are
suppressed in the Measurement menu. “Non-standard handset” and
‘non-standard hands free” select handset or hands-free tests,
respectively, which can be customized.

The next window is for selection of relevant measurements according to
tested device type, codec bandwidth, test signal and Release of the
3GPP standards TS 26.131 and TS 26.132. All testcases relevant for
the selected combination will be offered in the “Release” menu.
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Select Release

Fordeel &

Norowbard &

Atificial voice ITU-T P.50 2

Felease 10(TS 261311040, TS 26132 10.3.0] =]

—

Fig. 7  Query window for the Release menu

Select Ear Simulator

Fig. 8  Query window for selection of artificial ear
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®5elect mouth type  [H[=]

LRGFITU-T P.51

HATS ITU-T P52

Genenc speaker

Elechic connection

[T Da not show this dislog again

Cancel

DkJ//
f

Fig. 9

Query window for selection of artificial mouth

When the checkbox “Do not show this dialog again” is checked, the
corresponding selection window will not appear at the program start in
future. However, the selection is still available in the “Options” menu
(see below). After the last of the four selection windows has been

closed, the main window of the R&S UPV-K9 opens.

@)UPV—K‘]x Mobile Phone Tests {D:43GPPResults.kml)

File Data Calbration Measurement Standards Release  Config, Meas,

Testresults overview

Sequence Report  Options  Help

(o]

Select| Date and time | Measurement itl | Test abject | Werdi | Main Result =
L — 02A17/2012 15:33.55 3GPP Echo logs handget, nom, vol., Rel 10 PASS Echo Loss = B6.4 dB
- 02A17/2012 15:40.58 3GPP Echo loss handset, all vol. steps, Rel 1 PASS EchoLoss =664 dB
- 02A17/2M2 154215 3GPF Idle channel noise receiving, max, vol., PASS | Idle Channel Noise Receiy
- |02/17/2012 15:42.58 3GPP Idle channel noise receiving, max. vol., Pa55 | Idie Chan. Naise Rec.. Rig
- |02117/201215:44:13 3GPP Idle channel noise receiv. WE, nom. vol P55 Idle Channel Noise Receiy_
- 02M7/202 154446 3GPF Idle chan. noise rec. 'WE, nom. vol., Bin PA5S Idle Chan. Noise Rec., Ric
- |02M7/201216:31:29 3GPP DTHF Sending MMS, Rel. 10 FAIL | Sending Loudness R ating
- 02772012 16:32.23 3GPP DTHF Sending MMS, Rel. 10 FAIL | Sending Loudness R ating
- | 02A17/201216:37:18 3GPP DTHF Receiving MMS, Nom. Voal.. Rel. FAIL | Receiving Loudness Ratir
- |02/17/2M216:3811 JGPP DTHF Receiving MMS, Nom. Vol.. Rel. FAIL | Receiving Loudness Aatir
- |02/17/2012 16:40:56 3GPP DTHF Receiving MMS, Max. %ol Rel. 1 FAIL | Receiving Loudness Ratir
- |02117/201216:42:28 3GPP HF Distortion Receiving NE, Rel. 10 FAIL Lo limit margin, SIMAD «
- |0217/2012 16:46:41 3GPP HF Echo loss, nom. vol., Rel 10 P255 Echo Loss =54.5dB
- |02M17/2012 16:48:52 3GPP HF Echo loss, all vol. steps, Rel. 10 PASS Echo Lozz=43.4 dB
- 027202165111 3GPP DTHF Sending P50, Rel 10 FAIL | Sending Loudness R ating
- |02117/2M2 16:53:38 3GPP DTHF Receiving P.50, Nom. Val., Rel 1 FAIL RLR=123dE
- |02/17/2012 16:56:02 3GPP DTHF Recaiving P50, Max. Vol Rel. 1 Fall RLR=118dB
- 02/17/202 16:58:03 3GPP HHHF Sending P.50, Rel 10 FAIL | Sending Loudness Rating
- 0ZM7/2M2 170026 3GPP HHHF Sending MMS, Rel 10 FAIL | Sending Loudness Fiating
- 02M7/202 170051 3GPP HHHF Receiving tS, Mom. Val., Rel. FAIL  Receiving Loudness Ratir
- 021772012 17:.04:44 3GPP HHHF Receiving MMS, Nom. Vol Rel. FAIL | Receiving Loudness R atir
- |02A72mz 170552 3GPP HHHF Receiving P50, Nom. Yal, Rel FAIL RLR=11.8dE
- |02117/2M217:.06:36 3GPP HHHF Receiving P50, Max Yol Rel PASS RLR=11.6dB
- 02/17/202 17:08:38 3GPP HHHF Receiving P50, Min. Yol Rel 1 PASS RLR =120dB
3GPP HHHF Receiving MMS, Max Yol , Rel PASS | Receiving Loudness Ratir
3GPP HHHF Receiving MMS, Min. Wol., Rel. FA55 Receiving Loudness Fiatir
AGPP VMHE Reraivinn S Mam ol Rel Fall

Recaivinn | andnass nili.—;
»

|36PP Binaural Heads wide HATS Typs 33 Am Ear  |CMU / CBT |
| | FBeportlast |

Repaort last
measLremeant

HTC|Handsat MNE P50 Release 10

SEQUENGE.

| Exit |

Fig. 10 Main window

Initially the data grid in the centre of the screen which shows the result
overview is empty. The screenshot in Fig. 10 shows an example after a

number of measurements have been made.

By clicking with the right mouse button on the data grid, a context menu
opens which allows to create a report of a result marked by a solid
triangle in the respective row header, edit the comment for a marked
result, to delete the marked result or to export one of the curves in the
marked result graph to an ASCII format.

15
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falll

Creake Report For Marked Fow

5
Edit: Comment of Marked Row El
Delete Marked Row
A0, nom. Wal,
Save Curve of Marked Row as ... - o e,
Report Selection Report Selected Resulks
Sart Chronologically Select all
£:31:36 3GPP STMR P50, HATS EETF‘:E‘; T" o
F:33:.42 IGPP STMA MMS, HaTo Zooe 2 erer REss

Fig. 11 Context menu of the result data grid

Fig. 12 A triangle in the row header indicates a marked row

The “Report Selection” submenu allows to report on or delete a
selection of results which have been marked in the “Select” column of
the data grid. To select or unselect a result, click in the “Select” column
of the respective row. Selected rows show “XXXXX”, unselected rows
show “------- “in this cell.

If the results have been sorted alphabetically according to one of the
columns by clicking on the respective column header, the chronological
order can be restored using the context menu item “Sort
Chronologically”.

Operating Concept

R&S 3GPP mobile phone tests consist of the main user interface
window which allows general settings, calibration routines, data
handling, automatic sequencing and reporting tools, and of test macros
for basic measurement types defined in the standards. Each
measurement type provides a set of parameters (R&S UPV setup files,
limits etc.) which are defined in separated measurement definition files,
one for each test case.

16 E-6
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Options (General settings)

Options  Help
| Standard

Select standard at starkup
Release

v Seleck release at skarkup
Ear Sirnulator
Select ear simulatar at startup
Artificial routh

Select artificial mouth at startup

System simulator

Hands free settings

Ackivation signal for diskortion tests r

Showe operator instructions

MU rernote control

MU Subswstem

Input switcher

Report settings

Generakte temporary export files

Generakte kemporary image files

Store results of Further measurements
v Do not change scale for Further meas,

Store loaded curve data ko resulks

Enable remote control

Fig. 13 Options menu

The “Options” menu in the main window allows to change a set of
general settings like ear type and mouth type used which are valid for all
or at least a plurality of the tests.

“Standard” allows to select one of the available standards.
Measurements belonging to this standard will be checked in the
measurement menu. If “Allow only standard measurements” is checked,
it is not possible to start single measurements which do not belong to
the standard.

If “Select standard at startup” is checked, the selection window for
the standard is opened at each start of the program.

“Release” opens the window to select type of tested device, codec
bandwidth, test signal and Release of 3GPP standards TS 26.131 and
26.132 to be applied. Any change in these settings will re-build the
“Release” menu with the applicable testcases.

If “Select release at startup” is checked, the selection window for the
“Release” menu is opened at each start of the program.

“Ear simulator” allows to select the type of ear simulator used. For
details on the handling of calibration data see section 4 “Calibration”
below.

If “Select ear simulator at startup” is checked, the selection window
for the ear simulator is opened at each start of the program.

“Artificial mouth” allows to select the type of artificial mouth used. For
details on the handling of calibration data see section 4 “Calibration”
below.

If “Select artificial mouth at startup” is checked, the selection window
for the artificial mouth is opened at each start of the program.

17 E-6
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“System simulator” allows to select the type of system simulator used.
For details on the handling of calibration data see section 4 “Calibration”
below.

“Hands free settings” allows to select the acoustic instruments used
for hands free testing. It is possible to use an ITU-T P.51 artificial mouth
together with a free field microphone, a HATS with one artificial ear or a
HATS with two artificial ears. If two artificial ears are used, the decoder
has to be disconnected from analyzer input 2 and the second artificial
ear has to be connected to it for receiving measurements. Do not forget
to re-connect the decoder for any measurement in sending direction.

In the sub-menu to “Activation signal for distortion tests”, signals
can be imported to the test system. If more than one imported signal is
available, it is possible to choose one of them for actual use.

Import Activation Signal

Browese to an appropriate wavwe file.

The file must be recorded in mono with 48 kHz
zample rate.

td aximunm permissible length iz 10 seconds.

File Marme Browse

|D AUPYAsertitalett] 1 48kHz waw

Sample Rate I 43000 Hz

= {vono =) Gteren

Druration I 2596 Seconds
Average Level I -21.19 dBFS
Active Level I -19.73 dBFS

W Equalize for Selected Artificial Mouth

[ Immediately select thiz activation signal

Cahcel Ol

Y

Fig. 14 Window for import of activation signals

Use the “Browse” button to select a wave file which fulfils the conditions
shown on top of the window. The selected signal is analyzed and
checked for appropriateness. Note that a high crest factor of the signal
may overdrive the codec or artificial mouth. If “Equalise for Selected
Artificial Mouth” is activated, the file is immediately equalized for the
selected artificial mouth when the “Ok” button is clicked. Otherwise, or
when the mouth calibration has been re-done or a different artificial
mouth has been selected in the meantime, the signal is equalized
automatically immediately before the sending distortion test starts.

If “Immediately select this activation signal” is checked, the signal is
selected for use when the “Ok” button is clicked.
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If “Show operator instructions” is checked, instructions to the
operator are displayed in a window before the measurement starts. The
operator may be prompted to position the mobile in a defined way or to
set the volume to a certain setting.

If it is intended to remote control a R&S CMU200 from a sequence of
this program, menu item “CMU remote control” can be used to select
the communication interface (GPIB or RS-232) and, if multiple devices
are found, to select one of them.

CMMU
— CHU Bemate Contral
aff viaGFE | viaRS232 |
~GPIB
Bsice [GPIBE::19: RiohdetS chwerz,CMU 200-1100.0008.02,108662,Y5.13 =]
—RS5-232
COM Inteiface. [COMB: RiohdetSchwarz, CMU 200-1100.0005 02,1 08562513 =]

Cancel | Ok I
v

e

Fig. 15 Window for import setting the CMU remote control

For remote control via RS-232, an external USB-to-serial converter has
to be connected and installed. For remote control via GPIB, the
R&S VISA has to be installed. The installer for the R&S VISA is
distributed with the Option R&S UPV-K91. For details of the remote
control see section 8 and the operation manuals of the R&S CMU200.

In “CMU subsystem”, one of the communication standards / GSM
frequency bands can be selected. This allows sequences to be run in
different GSM bands without changing the subsystem in every single
CMU control instance in the sequence.

‘Input Switcher’ allows to configure the use of a R&S UPZ input
switcher connected to the R&S UPV RS-232 port, to switch analyzer
input 2 between sending tests and binaural receiving tests.
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Switcher Settings

r Ilze UFZ input switcher to connect secand artificial
ear for binaural measurements and calibration

UFZ output connected to analyzer input 2

COutput A, Cutput B

Decoder output connected to LUIFE inpuk no. I 15:

2nd artificial ear connected bo UFE input no. I 25:

Cancel | Ok I
Y

o

Fig. 16  Switcher window

“Report settings” allows to define the type of information which should
appear in the reports. For details on reporting, see section 8 below.

If “Generate temporary export files” is checked, some of the
measurement macros create “result.exp” with result value and verdict,
and, if applicable, “curve.exp” or “abscurve.exp” and “relcurve.exp” files
with curve data in ASCIl format. This function is provided for
compatibility with R&S UPL-B9.

ltem “Generate temporary image files” causes the measurement
macros to store a screenshot of the measurement window after
completion of the test to a file “Image.TIF” for use by a remote
controlling host.

If “Store results of further measurements” is checked, curves and
calculated values like loudness ratings are also stored for additional
measurements started with the “Add Measurement” key. They will
appear in reports of the respective measurements.

Menu item “Do not change scale for further meas.” deactivates the
automatic Y-axis scaling if the curve of an additional measurement
leaves the plot area partially or totally.

If “Store loaded curve data to results” is checked, curves loaded
from file with the “Load Curve” softkey are stored to the results
database and will appear in reports of the respective measurements.

Attention: Do not attempt to modify files with extensions “set”, “sup”,
“xml”, “cal” “seq” or “mdf”, using a text editor. Any change
with a text editor may make the files unusable and cause
malfunction of the software.

Menu item “Enable remote control” activates the interface of the
program for remote control using the client “ControlK9.exe”.
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Calibration Devices

R&S UPV-K9 allows to simultaneously store calibration values for
multiple individuals of the same type. This allows to switch devices
without the requirement for re-calibration. However, regular re-
calibration is recommended in order to assure the correct function of
the used devices.

Calibration  Measurement  Standar

! v Selective I
Microphone 3
Artificial Ear k
DRP ko ERP correction k
Free field equalization L

»

»

»

TTT oo

Diffuse Field equalization
Artificial Mouth

Artificial Moukh (Hands Free)
Codec L
Induction coil L
Electric connections L3 &
P.50 Speech Ref. Spectrum k|
Ambient noise Field L
Mew Device L
Select Device L
Delete Device L
Shows all walues L

Show selecked devices L

Fig. 17 Calibration menu

For every device to be calibrated, an entry must be created using
“Calibration > New device” in the main menu. This menu item opens
an entry window to specify the calibrated device. A category of device
must be chosen from the combo box on top. Type, manufacturer and
serial number are entered into the text boxes below. The entries are
confirmed by clicking on the “Save and close” button. If the box
“Immediately select this device” is checked, the device is selected for
immediate use with the “Save, select and close” button.

For ease of use, a “default” device is present and selected for each
device type (category) upon first start of the program.
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Calibrated Device

L

zage

Type

=

i

anufacturer

Serial Murnber

[T Immediately select thiz device

Cancel | |

Save and cloze

7

Fig.

18 Input window for information about calibrated device

Before a device can be calibrated or used, it must be selected. This can
be done from the “Calibrated Device” input window if the checkbox
‘Immediately select this device” is checked. Existing devices may be
selected with “Calibration > Select device” in the main menu. Clicking
on this item opens a window with a table of all entered devices.

Select Calibrated Devices

| File name |

¢ | Manutacturer | Typs | SeiiglMo. | Date and Time | Calib. walue
4 ymbie Detault 08/29/2007 17.21 [rwll]
Decoder Default 07/13/2006 17.50 [ruall)
Diffuse field microphane Default 07/13/2006 17.57 [rull)
Electric connection replacing decoder Detault 07/13/2006 17.54 [rull)
Electiic connection replacing ear Diefault 10/411/2007 11,36 [rull]
Electric connection replacing encoder Default 07/13/2006 17.54 [ruall)
Electric connection replacing mouth Default 07/13/2006 17.51 [rull)
Encoder Detault 07/13/2006 1751 [rull)
Free field microphone Diefault 06/07/2008 1550 [rull]
Generic speaker Default 07/13/2006 16:33 [ruall)
HATS ITU-T P53 Art. Mouth Detault 06/07/2006 15:47 [rull)
HATS Type 3.3 Art. Ear Detallt 06/07/2006 15:52 [ruill]
HATS Type 3.4 At Ear Detault 06/07 /2006 15:54 [rwll]
Induction coil (input] Default 07/13/2006 18:.04 [ruall)
Input digital Detault 06/07/2006 15:43 [rull)
LRGP ITU-T P51 Art. Moth Detallt 07/13/2006 17:59 [ruill]
Output digital Detault 06/07 /2006 15:50 [rwll]
Second Type 3.3 At Ear Default 07/11/2007 15:.09 [ruall)
Second Type 3.4 &t Ear Default 07/11/2007 15:.09 [rull)
Type 1 &t Ear Detault 06/07/2006 15:51 [rull)
7l Tupe 3.2 Hioh Leak &t Ear Diefault 08/07 /2006 1551 Trclll |
|Se\ect uzage type firstl j Select Cancel |

DAIGPPACa
DMIGPPACa
DMIGPPACa
D:AIGPPACa
DAIGPPACa
DMIGPPACa
DMIGPPACa
D:AIGPPACa
DAIGPPACa
DMIGPPACa
DMIGPPACa
D:AIGPPACa
DAIGPPACa
DMIGPPACa
DMIGPPACa
D:AIGPPACa
DAIGPPACa
D:A3GPPACa |
DMIGPPACa
D:AIGPPACa

D.\aaPP\EiLI
»

o ]

Fig. 19 Window for selection of calibrated devices

In the combo box lower left, a category of devices must be selected.
Subsequently the table is reduced to available devices in this category.
At first startup, there is only a “Default” device for each category, but
when more devices have been created with the “New device” function, a
choice will be available in this view. In this state a row in the table can
be marked with a mouse click on its left end. A mouse click on the

button “Select” selects this device for the associated usage.
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Select Calibrated Devices

Usage | b anufacturer | Type ‘ Serial No, | Date and Time ‘ Calib. value | File name

Tupe 3.2 Low Leak Ak Ear Bk 4195 1708754 04/22/2009 14:25 [ruall) D:A3GPPACA33:
Type 3.2 Low Leak &t Ear Diefault 07/13/2006 17.57 (rl) D:\3GPPACal33l
Type 3.2 Low Leak &t Ear G.R.AS RAODSE & Ra 26740 & 4636 | 04/22/2009 14:27 (rull) [:43GPPACal33l

»
|Type 3.2 low leak, art, ear j Select | Cancel | Ok I

Fig. 20 Selection window for particular device type

Subsequently this procedure may be repeated for other categories.
Finally all selections are confirmed by clicking the “Ok” button.

A calibrated device may be deleted, using menu item “Calibration >
Delete device”. The device to be deleted must not be selected for use.
Another device of the same type must be selected before the device
can be deleted. Select the device to be deleted the same way as in the
preceding paragraph the device to be used. Note that all calibration
information is deleted for this device except result data required for
reporting previous test results.

All calibration data are stored on the R&S UPV hard disk and are
therefore automatically available again after every restart. The
calibration values for the R&S UPV-K91 option are stored independently
of other options. Calibration values for 3GPP tests and CDMA2000
tests are handled separately.

All calibration routines below require as pre-requisite that a device for
the respective usage has been generated and selected.

To simplify the procedure for the case that it is not intended to use
multiple devices of the same category nor to include information about
the used devices into a report, there is a “Default” device selected for
each device type or category after the first start of the program.

An overview of all selected calibration devices together with the
calibration values is given under the menu item “Calibration > Show
selected devices”.
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Microphone Calibration

» Insert the measuring microphone fully into the adapter of the
sound level calibrator and switch on the calibrator. A '>” adapter or
Ys” adapter is required according to the microphone diameter.

Note: After inserting the microphone, wait about 10 s to allow
for static pressure equalization.

» Call the test routine with “Calibration - Microphone - Free field”
or “Calibration - Microphone - Diffuse field” from the main
menu, depending on the microphone.

Microphone calibration

Connect microphone to analyzer input 1.
Insert microphone into calibrator using
adapter UC0210 and switch on calibrator.

[ Calibration level increazed by 20 dB [not validated)

[ Delay start by I EIE: zeconds

Cancel | Ok

Fig. 21 Initial window of microphone calibration

For calibrators providing a sound pressure level of 114 dB (10 Pa), the
checkbox “Calibration level increased by 20 dB” must be checked. In all
other cases the checkbox must remain unchecked! If a calibrator with a
frequency other than 1000 Hz is used, make sure that the “Selective”
item in the Calibration menu is unchecked.

The output voltage of the microphone is measured and the sensitivity
displayed with reference to 1 Pa. If a mere power supply without gain is
used, the displayed sensitivity must approximately match the value in
the calibration certificate of the microphone cartridge (typical value for
microphone capsule 4134 of artificial ear 4185 is approx. 12 mV/Pa). If
a conditioning amplifier with 20 dB gain (recommended value) is used,
the displayed sensitivity must be about 10 times higher (e.g.
120 mV/Pa). If the voltage measured is below 3 mV, an error message
is displayed. Possible error sources are, for example, a switched-off
microphone power supply or a disabled calibrator. In this case, the
program requests that the test be repeated. After switching on the
microphone power supply, wait approx. 20s before starting the
calibration again.
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Calibration of Artificial Ear

Prior to the measurements, the absolute sensitivity of the microphone in
the artificial ear must be determined using a sound level calibrator such
as the Bruel & Kjaer 4231 with a sound pressure level of 94 dBSPL or a
sound pressure of 1 Pa at 1 kHz.

Calibration of Ear Type 1

>

Switch off the microphone power supply.

Attention: The 200 V polarization voltage of the microphone may
cause a slight electric shock. The current is harmless, but
the microphone preamplifier may be damaged.

Remove the microphone from the artificial ear.

Screw back the microphone capsule and switch on the operating
voltage.

Insert the microphone fully into the adapter of the sound level
calibrator and switch on the calibrator.

Note: After inserting the microphone wait about 10 s to allow for
static pressure compensation.

Select “Calibration > Artificial ear > Type 1” from the main
menu.

For calibrators providing a sound pressure level of 114 dB (10 Pa),
the checkbox “Calibration level increased by 20 dB” must be
checked. In all other cases the checkbox must remain unchecked!

The output voltage of the microphone is measured and the
sensitivity displayed with reference to 1 Pa. If a mere power supply
without gain is used, the displayed sensitivity must approximately
match the value in the calibration certificate of the microphone
cartridge (typical value for microphone capsule 4134 of artificial ear
4185 is approx. 12 mV/Pa). If a conditioning amplifier with 20 dB
gain (recommended value) is used, the displayed sensitivity must be
about 10 times higher (e.g. 120 mV/Pa). If the voltage measured is
below 3 mV or fluctuating by more than 0.2 dB, an error message is
displayed. Possible error sources are, for example, a switched-off
microphone power supply or a disabled calibrator. In this case, the
program requests that the test be repeated. After switching on the
microphone power supply, wait approx. 20 s before restarting the
calibration.

The reference value measured is stored in a file on the hard disk
and used for all subsequent measurements when the same artificial
ear type 1 is used as currently selected.

Calibration of Ear Type 3.2 Low Leakage

>

>

Connect the sound level calibrator tightly to the artificial ear using
the adapter DP0939 and switch on the calibrator.

Select “Calibration > Artificial ear > Type 3.2 Low Leak” from
the main menu.

For calibrators providing a sound pressure level of 114 dB (10 Pa),
the checkbox “Calibration level increased by 20 dB” must be
checked. In all other cases the checkbox must remain unchecked!
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The output voltage of the microphone in the ear is measured and the
sensitivity displayed with reference to 1 Pa. If the voltage measured
is below 3 mV or fluctuating by more than 0.2 dB, an error message
is displayed. Possible error sources are, for example, a switched-off
microphone power supply or a disabled calibrator. In this case, the
program requests that the test be repeated. After switching on the
microphone power supply, wait approx. 20 s before restarting the
calibration.

The measured reference value is stored in a file on the hard disk
and used for all subsequent measurements when the same ear type
3.2L is used as currently selected.

Reading the DRP-ERP Correction Data of the Artificial Ear of Type
3.2L:

The frequency response of the artificial ear of type 3.2L is supplied
on a floppy together with the artificial ear. The data is used for
transforming the measurement values from the drum reference point
to the ear reference point.

Connect a USB floppy disk drive with the calibration disk to the

R&S UPV, copy the file “OES_LL.ADA” from the manufacturer’s
calibration disk to a USB stick or a CD-ROM or make this file available
on a network drive via LAN.

Call the routine “Calibration > DRP to ERP Correction > Type 3.2 Low
leak”. Browse to the file “OES_LL.ADA” and click “Open”.

The calibration file is read. The modified data is stored on the
R&S UPV hard disk. This procedure needs only be repeated after a
change of the calibration data, e.g. after a recalibration of the ear by
the manufacturer, or when the “3GPP” directory has been renamed
or removed.

Calibration of Ear Type 3.2 High Leakage

>

>

Connect the sound level calibrator tightly to the artificial ear using
the adapter DP0939 and switch on the calibrator.

Select “Calibration > Artificial ear > Type 3.2 High Leak” from
the main menu.

For calibrators providing a sound pressure level of 114 dB (10 Pa),
the checkbox “Calibration level increased by 20 dB” must be
checked. In all other cases the checkbox must remain unchecked!

The output voltage of the microphone in the ear is measured and the
sensitivity displayed with reference to 1 Pa. If the voltage measured
is below 3 mV or fluctuating by more than 0.2 dB, an error message
is displayed. Possible error sources are, for example, a switched-off
microphone power supply or a disabled calibrator. In this case, the
program requests that the test be repeated. After switching on the
microphone power supply, wait approx. 20 s before restarting the
measurement.

The measured reference value is stored in a file on the hard disk
and used for all subsequent measurements when the same ear type
3.2H is used as currently selected.

Reading the DRP-ERP Correction Data of the Artificial Ear of
Type 3.2H:

The frequency response of the artificial ear of type 3.2H is supplied
on a floppy together with the artificial ear. The data is used for
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transforming the measurement values from the drum reference point
to the ear reference point.

Connect a USB floppy disk drive with the calibration disk to the
R&S UPV, copy the file “OES_HL.ADA” from the manufacturer’s
calibration disk to a USB stick or a CD-ROM or make this file
available on a network drive via LAN.

Call the routine “Calibration > DRP to ERP Correction > Type 3.2
High leak”. Browse to the file “OES_HL.ADA” and click “Open”.

The calibration file is read. The modified data is stored on the
R&S UPV hard disk. This procedure needs only be repeated after a
change of the calibration data, e.g. after a recalibration of the ear by
the manufacturer, or when the “3GPP” directory has been renamed
or removed.

Calibration of Ear Type 3.3

>

>

>

Remove the pinna from the artificial ear according to the
manufacturer’s instructions

Connect the sound level calibrator tightly to the artificial ear using
the adapter UA-1546 and switch the calibrator on.

Select “Calibration > Artificial ear > HATS Type 3.3” from the
main menu.

For calibrators providing a sound pressure level of 114 dB (10 Pa),
the checkbox “Calibration level increased by 20 dB” must be
checked. In all other cases the checkbox must remain unchecked!

The type 3.3 ear calibration requires the calibrator with adapter UA-
1546 to be held manually against the ear. If the HATS is installed
remote from the R&S UPV, the checkbox “Delay start by ...
seconds” can be checked and a time interval can be entered by
which the start of the calibration measurement is delayed. The
countdown is displayed on the R&S UPV screen.

Microphone calibration

Connect artificial ear to analyzer input 1.
Fut art. ear on calibrator with adapter part
lUA1546 and switch on calibrator.

[T Calibration level increased by 20 dB [not wvalidated)

W Delay start by I EE: zeconds

Cancel | Ok

Fig. 22 Ear calibration window with delayed start

The output voltage of the microphone in the ear is measured and the
sensitivity displayed with reference to 1 Pa. If the voltage measured
is below 3 mV or fluctuating by more than 0.2 dB, an error message
is displayed. Possible error sources are, for example, a switched-off

27 E-6



1402.0043.12

Acoustic Measurements on Mobile Phones

microphone power supply or a disabled calibrator. In this case, the
program requests that the test be repeated. After switching on the
microphone power supply, wait approx. 20 s before restarting the
calibration.

The measured reference value is stored in a file on the hard disk
and used for all subsequent measurements when the same ear type
3.3 is used as currently selected.

Reading the DRP-ERP Correction Data of the Artificial Ear of Type
3.3:

Call the routine “Calibration - DRP to ERP Correction > Type 3.3
2>From ITU-T P.57 Table 2b”. This procedure needs only be
repeated when the “3GPP” directory has been renamed or removed.

Alternatively it is also possible to load individual DRP-ERP correction
data from a calibration disk. This option is not conformant with the
standards.

Reading the Diffuse Field Equalization Data of the Artificial Ear of
Type 3.3:

From Release 10 of 3GPP TS 26.132, diffuse field equalization is
applied to receiving frequency response results with handset and
headset UEs. Call the routine “Calibration - Diffuse field
equalization > Type 3.3 >From ITU-T P.58 Table 3”. This
procedure needs only be repeated when the “3GPP” directory has
been renamed or removed.

Alternatively it is also possible to load individual diffuse field
equalization data from a calibration disk. This option is not
conformant with the standards.

Calibration of Ear Type 3.4

» Remove the pinna and the ear canal simulator, connect the sound

level calibrator tightly to the artificial ear using the short steel
adapter and switch the calibrator on.

Select “Calibration > Artificial ear > HATS Type 3.4” from the
main menu.

For Head Acoustics HMS Il, calibrator B&K 4231 must be used in
conjunction with the short steel calibration adapter.

The output voltage of the microphone in the ear is measured and the
sensitivity displayed with reference to 1 Pa. If the voltage measured
is below 3 mV or fluctuating by more than 0.2 dB, an error message
is displayed. Possible error sources are, for example, a switched-off
microphone power supply or a disabled calibrator. In this case, the
program requests that the test be repeated. After switching on the
microphone power supply, wait approx. 20 s before restarting the
calibration.

The measured reference value is stored in a file on the hard disk
and used for all subsequent measurements when the same ear type
3.4 is used as currently selected.

Reading the DRP-ERP Correction Data of the Artificial Ear of
Type 3.4:
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Call the routine “Calibration - DRP to ERP Correction > Type 3.4
- From ITU-T P.57 Table 2b”. This procedure needs only be
repeated when the “3GPP” directory has been renamed or removed.

Alternatively it is also possible to load individual DRP-ERP correction
data from a calibration disk. This option is not conformant with the
standards.

Reading the Diffuse Field Equalization Data of the Artificial Ear of
Type 3.4:

From Release 10 of 3GPP TS 26.132, diffuse field equalization is
applied to receiving frequency response results with handset and
headset UEs. Call the routine “Calibration - Diffuse field
equalization > Type 3.4 ->From ITU-T P.58 Table 3”. This
procedure needs only be repeated when the “3GPP” directory has
been renamed or removed.

Alternatively it is also possible to load individual diffuse field
equalization data from a calibration disk. This option is not
conformant with the standards.

Calibration of Artificial Mouth for Handset Tests

Before a mobile phone can be tested, the absolute sensitivity and
frequency response of the artificial mouth have to be measured and
corrected with the aid of a previously calibrated free-field or diffuse-field
(pressure-field) microphone. The measuring microphone removed from
artificial ear type 1 can be used for this purpose or an additional
microphone capsule is screwed to the microphone preamplifier. The
standard microphone is used as a reference for determining the
frequency response of the mouth. The frequency response of the
microphone can be ignored in the test frequency range (100 Hz to
8 kHz) (see also calibration certificate of microphone capsule).

Since interfering sound falsifies the corrections, the artificial mouth must
be calibrated in the anechoic and isolated test chamber. In order to
reject any noise present in the test chamber, it is recommended to
activate item “Selective” in the calibration menu.

First of all, a calibrated measuring microphone has to be selected.

> Select a reference microphone type with “Calibration >
Artificial mouth > Select reference mic”.

For the selected microphone type, a device must be selected and
calibrated (see above). This device must be connected to R&S UPV
analyzer input 1 via power supply/conditioning amplifier.

For calibration of a P.51 type artificial mouth using a diffuse field type
microphone (e.g. B&K 4131 or 4134) or a microphone from a Type1
artificial ear, fit the microphone at right angles to the mouth at the
mouth reference point (MRP) using the gauge supplied with the
mouth (positioning at right angles is necessary because diffuse field
or pressure-calibrated microphones have a flat frequency response
to sound from random incident direction and therefore exhibit an
emphasis on high frequencies with frontal sound incidence).

For calibration of a P.51 type artificial mouth using a free field
microphone, the microphone must be mounted in the axis of the
sound outlet of the artificial mouth.

For calibration of the HATS (P.58 type) artificial mouth, a 4"
microphone is clamped in the fixture attached to the HATS.
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> Call the calibration routine with “Calibration - Artificial mouth >
LRGP ITU-T P.51 = Without Reference Spectrum”, “Calibration >
Artificial mouth - LRGP ITU-T P.51 - with P.50 Ref. Spectrum”,
“Calibration - Artificial mouth > HATS ITU-T P.58 = Without
Reference Spectrum” or “Calibration > Artificial mouth > HATS
ITU-T P.58 = with P.50 Ref. Spectrum” from the main menu.

The sound pressure generated at the MRP is set to exactly -4.7 dBPa in
an automatic measurement routine at 1 kHz. The generator voltage
required is stored in a file on the hard disk and used as a reference for
all subsequent settings with the same artificial mouth. If the sound
pressure cannot be adjusted to -4.7 dBPa, an error message is
displayed with a request to check the connection of the artificial mouth
and to repeat the measurement. A possible error source would be that
the transformer supplied is not connected between the generator and
the artificial mouth.

The uncorrected frequency response of the artificial mouth is
measured and displayed. Next, the frequency response is measured
with the inverse frequency response correction automatically
selected in the generator (equalization). Residual errors caused by
nonlinearities of the speaker in the mouth are measured and taken
into account in the final equalization file as fine correction.

To verify the results, the absolute sound pressure versus frequency
is measured at a sound pressure of 4.7 dBPa (reference value for
most of the measurements). The absolute sound pressure at each
frequency must be within a tolerance band of +0.2 dB. Correct
calibration without interfering sound yields an almost straight line in
the middle between the two limit lines.

If mouth calibration with reference spectrum measurement is
chosen, the test signal is subsequently filtered with the inverse
mouth frequency response, and the resulting spectrum at the MRP
is recorded as reference for sending frequency response tests.

If a mouth calibration is performed without reference spectrum
measurement, previously recorded reference spectra are
invalidated. A sensing measurement using artificial voice according
to ITU-T P.50 can only performed after an additional reference
spectrum calibration (see below).

P.50 Speech Spectrum Calibration

For tests using artificial voice according to ITU-T P.50 as test signal, the
spectrum of the test signal has to be measured and stored as reference
spectrum for the transfer function (gain) calculation. For sending and
sidetone tests, the signal has to be filtered in addition with the inverse
frequency response of the artificial mouth. A calibrated reference
microphone must be placed at the Mouth Reference Point (MRP) for
this purpose. It is recommended to perform the reference spectrum
calibration directly after the mouth calibration, using sub-menu item
“Calibration—> Artificial Mouth > ... > With P.50 Ref. Spectrum”.

The reference spectrum calibration for the receiving direction does not
require external equipment or wiring. The reference signal at the output
from the R&S UPV generator to the speech input of the system
simulator is measured via internal connection to the R&S UPV analyzer
input. For narrow-band tests in receiving direction, a band-limited
version of the test signal is used. Each version of the test signal has to
be calibrated separately.
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For ambient noise rejection according to Release 10 of 3GPP TS
26.132, a separate speech reference spectrum calibration is necessary
because the active speech level at the MRP is specified to be
+1.3 dBPa instead of -4.7 dBPa for this test. The test routines can be
found in sub-menu “Calibration _ > P.50 Speech Ref. Spectrum >
Sending for ANR”.

|Calil:uratiu:un Measurement  Standards Release  Config. Meas, Sequence  Report  Options

1 Microphone b zurement title | Test ohject
i il : ' b Echa logz handset, nom. val., Bel. 10

DRF to ERF correction ' b Echo lozz handzet, all vol steps, Rel 1

FTEE FiEh?I equaliza.ticur! " b ldle channel noise receiving, max. ol ,

DIFF,L!S? field equalization 4 Idle channel noize receiving, max. wol.,

Arcficial Mouth 4 |dle channel noize receiv. WEB. nom. vol.

Artificial Mouth (Hands Free) b 1 |dle chan, noige rec. WE, nom. vol., Bin,

Codee P DTHF Sending MMS, Rel. 10

Induction coil B DTHF Sending MMS, Rel. 10

Electric connections P b e e o Vol Fel.

P.50 Speech Ref, Spectrum Receiving Y o Vol Rel.

Ambient noise field Sending Handset  » ax. Vol Rel 1

Mew Device Sending Handsfree ® o Ao 44

Select Device Sending for AR, 4 Ark. Mouth LRGP ITL-T P51

Art, Mouth HATS ITU-T P.5&
Generic Speaker
Electric Connection

Delete Device
Showy all values
Show selecked devices

HF Echo loss, all vol. st
DTHF Sending P.50, Re
DTHF Receiving P50, |

Fig. 23 Submenu for reference speech spectrum calibration

Calibration of CMU Speech Coder

The calibration of the speech coder and decoder is necessary to be
able to calculate absolute loudness. Calibration has to be performed
only once and must be repeated only if the R&S CMU200 used is
replaced. If the R&S CMU200 is equipped with model 14 of the Link
Handler R&S CMU-B21, GSM as well as WCDMA use the same paths.
Calibration of the coder is therefore identical for both operating modes
and need not be repeated when switching from GSM to WCDMA or vice
versa.

If GSM and WCDMA use different link handlers, separate calibration
devices have to be generated for the two link handlers (i.e. with and
without the supplied adapter).

Note that encoder and decoder are handled as separate devices but
calibrated with one routine.

Auxiliary settings required for calibration can be found in the
R&S CMU200 under Bit Stream (for GSM) and under BS Signal,
Dedicated Channel, Voice settings (for WCDMA) (firmware version 4.52
or higher). Call the calibration routines with “Calibration - Codec” from
the main menu.

The following information is displayed:
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Eskahblish call and set 'Bit Stream’ bo 'Decadercal'l

Fig. 24 Message box during decoder calibration

Set up a call to the mobile phone. Set bit stream or voice setting on the
R&S CMUZ200 to "Decoder Cal" and then click the “OK” button.

The actual voltage at the decoder output of the R&S CMU200 is now
measured for a digital full-scale signal and the required correction value
is calculated and saved in the R&S UPV. The following request is then
displayed:

Set ‘Bit Stream' ko ‘EncoderCal'l

Fig. 25 Message box during encoder calibration

After the “OK” button has been clicked, the input sensitivity of the
speech coder is measured and the input voltage required for digital full
scale is measured at the speech coder and saved in the R&S UPV.

Calibration of Ambient Noise Field

3G Ambient Noise Adjustment N [=]

|Nn Standard |D|Huse field microphone |EML| fCRTU | |
Adjust )
m Adiust Level

Fig. 26 Measurement window for ambient noise field calibration.

Start
easurement

Enter

Camment ==

[Sreate Fegort

Stop
Aafiistnent | Change Scale
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Please refer to application note 1GA51, available on the R&S download
web site, for suggestions how to generate the noise field for the ambient
noise rejection test. For the calibration of the noise field for ambient
noise rejection tests, all obstacles (test head or HATS, Telephone etc.)
have to be removed from the test chamber. For the generation of the
noise field, additional equipment is necessary. The noise field should
have sufficient homogeneity (sound pressure level independent of
place) and diffuseness (randomly incident sound at the place of the
microphone). This can either be achieved in a reverberation room with
omni-directionally radiating sound source or in an anechoic room with a
number of uncorrelated noise sources. Limited homogeneity can be
achieved in the centre between two speakers. For good diffuseness a
minimum of four speakers distributed in different spatial directions are
required.

A diffuse field or pressure field microphone must be positioned at the
spot of the mouth reference point of the (removed) test head or HATS.

The menu Item Calibration - Ambient noise field opens the window
shown in Fig. 26.

The button “Adjust Spectrum” starts a continuous spectrum
measurement which allows to adjust the spectrum of the noise, e.g.
using equalizers. The template is centred around the curve irrespective
of the absolute level.

1
@)35 Ambient Noise Adjustment =] E3

-5

=20

Unweighted spectum [dB]

-50

i 1
63 100 1000 12100

Frequency [Hz]

No Standard [Diffuse field microphane |CMU £ CRTU | [

Aedjiist
Spectim

Start
IAeasurEment

Efiter
[EammEnt

Stop
Adjustment

st level

| [Ehange Seale: [Ereste Heport [Hlaze:

Fig. 27 Measurement window for spectrum adjustment.

The continuous spectrum measurement can be aborted by clicking
“Stop Adjustment”.

The button “Adjust level” starts a continuous level measurement. If a
multitude of sources is used, each source must produce a sound
pressure level of -24 dBPa — 3 * LOG n dB, whereby n is the number of
noise sources.
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436 Ambient Noise Adjustment _[O[x

Coarse dBFa(A) 224 Fine

=225+

234

-23.5%54

Diffuse field miciophone  |CMU / CET

Stop
Adjsstment

Fig. 28 Measurement window for level adjustment.

The left thermometer column gives a coarse overview. The right column
has an enlarged scale for fine adjustment. The numeric field in the
centre shows the numeric value.

The continuous level measurement can be aborted by clicking “Stop
Adjustment”.

Once the noise field has been adjusted, the result can be documented
by pressing “Start Measurement”. Although there is no calibration value
to be used in the ambient noise rejection measurement, the level is
stored and can be included for reference in the measurement report.

3G Ambient Noise Adjustment N [=]
14 5

20

Unweighted spectrum [dB]

1 1
63 100 1000

i
12100
Frequency [Hz]

B tieasured, Noice = -23.78 dBPaly) [ Upper imit [ Lower fmit

No Standard Diffuse field microphone  |CMU / CRTU
Save Curve As Add Enter
Save Curve As Load Curve Lirnt File Measurament Comment Change Scale Create Report Cloze

Fig. 29 Result of ambient noise calibration.
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4 Data Entry for Reporting
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Operator

Under “Data->Operator” an operator’'s name can be entered which is
stored in association with all calibration and measurement results. If
“Operator” is activated in the report settings, the name will appear in all
reports about these measurements.

Test object

Under “Data - Test object > New” a description of the device under
test can be entered.

Test Object

Mame

Type

t anufacturer

Serial Murnber

[ Immediately select this test object

Cancel | | Save and cloze

7

Fig. 30 Window for input of information about a test object

If the checkbox “Immediately select this test object” is checked, the test
object associated with the entered data is automatically selected upon
closing the window. The data of this selected test object will be stored in
association with all measurements and appear on the associated
reports if “DUT information” is activated in the report settings.

A previously entered test object can be selected with “Data -> Test
object > Select”.
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General

Special problems caused by the coding and decoding algorithms of
mobile phones are encountered when measuring acoustic
characteristics. Voice codecs are used to attain the lowest possible data
rate. Mobile phone voice codecs are optimized for transmitting human
speech with low data rate. Not the actual voice signals but only the filter
and fundamental parameters required for signal reconstruction are
transmitted.

Purely sinusoidal tones normally used for audio measurements cannot be
transmitted with such a system. Therefore, the coder and decoder had
initially been excluded from the measurement, which required a
specially prepared test mobile phone with a specific test interface.

In modern mobile phones, this interface is not available anymore.
Measurements are generally performed via the air interface with the
speech coder and decoder included. As mentioned above,
measurements using sinusoidal tones cannot be performed because
the static sinusoidal input signal becomes a more or less stochastic
output signal as a result of coding, particularly in the medium and high
audio frequency ranges.

Signals similar to voice therefore have to be used for the measurement, i.e.
either artificial voice according to ITU-T P.50 or a multitone signal according
to ITU-T P.501 is possible. At the same time, modulation of the signal in
time must largely correspond to voice, since many modern mobile phones
use algorithms for interference suppression which use the modulation to
distinguish the useful from the interfering signal.

The test routines in the R&S UPV-K91 use an amplitude-modulated
multitone signal according to ITU-T P.501 as described in 3GPP TS 26.132
or alternatively artificial voice according to ITU-T P.50 (update key UPV-
K9101 or UPV-K9102 required).
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Starting measurements

Measurements can be started from the “Measurement” menu. This
menu contains either all available measurements, or the measurements
belonging to the selected standard if the checkbox “Allow only selected
measurements” in the “Options - Select standard” window is checked.

The menu “Standards” allows to start any measurement, whereby the
measurements are structured into submenus according to the
standards to which they belong. This allows a quick and easy access to
all available measurements.

|Standards Release Config. Meas. Sequence Repart  Options  Help

ack nhicrk ['tardi | b i Bacilk

3GPP Hand3 and Heads Marrow MMS
3GPP HandS and Heads Marro 3GPP Sending Handset, P50
3GPP HandS and Heads Marrow MMS, Rel, 10 3GPP Receiving Handset P50, nom. Yol,
3GPP Hand3s and Heads Marrow P50, Rel, 10 3GEPP Receiving Handset P.50, nom, Yol,, Rel, &
3GPP HandS and Heads Wide MMS, Rel, 6/7 3GPP Receiving Handset P50, max, Yol,
3GPP HandS and Heads Wide P.50, Rel. 6/7 3GPP Receiving Handset P50, min. Yal,
3GPP HandS and HeadS Wide MMS, Rel. 8 3GPP Idle channel noise sending
3GPP HandS and Heads Wide P.50, Rel. & 3GPP Idle channel noise receiving, nom, vol,
3GPP HandS and Heads Wide MMS, Rel. 10 3GPP Idle channel noise receiving, masx, vol,
3GPP Hand3s and Heads Wide P.5S0, Rel, 10 3EPP Distortion sending Rel, 4/5
3GPP Binaural HeadS Marrow M3, Rel, 10 3GPP Distortion sending Rel, &
3GPP Binaural Heads Matrow P50, Rel. 10 3GPP Distortion Sending, Rel. 9
3GPP Binaural Heads Wide MMS, Rel. & 3GPP Distortion receiving
3GPP Binaural Heads Wide P.50, Rel. § 3GPP Distortion Receiving, Rel, 9

3GPP STMR P50, LRGP Method

3GPP Binaural Heads Wide MMS, Rel, 10

3GPP Binaural HeadS Wide P.S0, Rel, 10 3GPP STMR P50, LRGP Method, Rel, 8.2

JGEPP HHHF Marrow 3GPP STMR P50, HATS Method, Nom, Yal,

3GPP HHHF Matrow, Rel. 10 3GPP STMR P50, HATS Method, Mom. Yal., Rel, 8.2+9

3IGPP HHHF YWide, Rel. 6/7 3GPP STMR P50, HATS Methad, All Yaol. Steps

3GPP HHHF "Wide, Rel. & 3GPP STMR P50, HATS Method, All Vol, Steps, Rel, 8.2+9

3GPP HHHF 'Wide, Rel, 10 3GPP Stability margin

3GPP DTHF and YMHF Marrow 3GPP Echo loss with training

3GPP DTHF and YMHF Marrow, Rel, 10 3GEPP Ambient Moise Rejection P.50

3GPP DTHF and YMHF Wide, Rel, 67 3GPP AMR P50, w. 3dE uncertainty allowance

3GPP DTHF and YMHF W?de, Rel. 8 PASS FLR = 12.0 dB
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Fig. 31 “Standards” menu with submenu for narrow band handset
tests according to 3GPP TS 26.132, using artificial voice according to
ITU-T P.50.

The menu “Release” offers all applicable test cases for a selected
combination of UE device type, speech codec bandwidth, test signal
and release of the 3GPP test specifications. Item “Select Release”
opens the selection window of Fig. 7. Sub-menu “Settings” has the
same test case entries and allows to open the editing window of Fig. 66.
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| Release Config. Meas., Sequence Report  Options Help
Select Release
Settings 3
3GPP Sending Handset, P50
3GPP Receiving Handset P.50, nom, Yol., Rel. 10
3GPP Receiving Handset P.50, ma:x, Yol,, Rel, 10
3EPP Receiving Handset P50, min, Wol., Rel. 10
3GPP Idle Chanmel Moise Sending, Rel. 10
3GPP Idle channel noise receiving, norm. vol., Rel. 10
3GPP Idle channel noise receiving, max, vol,, Rel, 10
3GPP Diskortion Sending, Rel, 9
3GPP Diskortion Receiving ME, Rel, 10
3GPP STMR P.50, HATS Method, Mom, %al., Rel. 10
3GPP STMR P.50, HATS Methad, All wal, Steps, Rel, 10
3GPP Stability loss ME, Rel. 10
3GPP Echo loss handset, nomm, wal.,, Rel. 10
3GPP Echo loss handset, all vol., steps, Rel. 10
3GPP ANR PLEO, Rel. 10
3GPP ANR P.5O0, w, 3 dB uncert. allow., Rel, 10
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Fig. 32 “Release” menu

A fourth possibility to start a single measurement is the button “Run
highlighted as single measurement” in the sequence menu (see
chapter 7 below).

Functionality and control of the measurement

macros

r
=}

Sending sensitivity [dB re 1Y/Pa]

30 I I
100 1000 10000
Frequency [Hz]

m Measured, SLA = 9.55 dB . Upper limit . Lawer limit

|36PP Hands Mamow  |Type 3.2 Low Leak ArtEa |CMU / CET |5ample Oibject [

Save Curve as | Load Curve

Fig. 33 Example of a measurement window

When a measurement macro is started, e.g. from the “Measurement”
menu, the standardized measurement is immediately executed. With a
single measurement, the window of the measurement macro stays
open after the measurement is terminated. At that time, the following
functionality is available:

Add
Measurement

Save Curve ag
Lirnit File

Erter
Comment

| Delete Curve Create Report Cloze
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Fig. 34 Context menu of the graph window

Zooming

When the “Shift” key on the keyboard is pressed, the mouse cursor
changes to the zoom cursor. When the left mouse button is pressed, a
rectangle can be marked in the graph. As soon as the left mouse button
is released, the graph is zoomed into the area of the marked rectangle

“Zoom Out” in the graph context menu reverses the last zooming step.
“Unzoom” zooms completely out to the original scaling.
Changing the Scale of the Graph

“Change Scale” in the context menu opens a window in which the upper
and lower bounds of both axes can be entered by numbers.

@Ehange Scale =]

# binirmum = b arimunm
| 100. EIIII::I | 1 IIIEIEIIZI.EIEI::I
" MiriravLrm v M amirnLinm

| S000=] | 0.00=]
Cancel ok |
aNCE | /

o

Fig. 35 Window for changing the scale of the graph

Cursor

When the item “Show Cursor” is marked in the graph context menu, a
cursor is displayed which can be dragged along the graph with the
mouse. X and Y values of the data points below the cursor are
displayed.

Data Point Size

“Data Point Size” in the graph context menu opens a window in which
the size of marks at the measured data points can be specified. Moving
the mouse cursor over one of the marks causes the associated X and Y
values to be displayed.

Entering a Comment

With the softkey “Enter Comment” or the item “Comment” in the graph
context menu, a comment can be entered and edited which will appear
in the report about the respective measurement.
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Storing a Hardcopy of the Graph

”

With the menu item “Save Screenshot as ...” in the graph context
menu, a hardcopy of the current graph window with all numeric displays,
legend etc. can be stored as image. The current view of the graph
including additional curves, current scaling and size is copied. However,
colours are inverted to a printer-friendly colour set.
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Fig. 36 Hardcopy of measurement graph

Making Additional Measurements

The softkey “Add Measurement” triggers another measurement
according to the specification of the test. Loudness ratings and other
result values like total noise level are calculated and displayed in the
legend. The additional curves and results will appear in the report if item
“Store results of further measurements” had been activated before the
measurement was started. However, limits are not checked for
additional measurements.

This function can e.g. be used to find the correct volume setting to pass
nominal RLR. It can further be used for adjustments in the device under
test.

Storing and Loading Curves

All curves in the graph can be stored to an ASCII file (*.tra), and such
curves can be loaded back into the graph. For easy import to Excel the
csv format is also offered. The softkey “Store Curve” opens a window in
which a combo box offers choice between the legends of all curves in
the graph. The curve associated in which the selected entry is stored to
the file with the specified format at the specified location.

If the “Options” menu item “Store loaded curves to results database” is
checked, loaded curves are stored together with the measurement
results and will appear in reports about the measurement.

Frequency response curves may also be stored as (relative!) UPL-
compatible trace files.
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Storing Curves as Limit Curves

With “Store As Limit Curve” a curve can be selected and stored into a
R&S UPV format limit file with a specified shift in Y axis direction. This
functionality can be used to generate limit curves from “golden” devices
for evaluation purpose.

Deleting Additional Curves in the Measurement Graph

By pressing or clicking “Delete Curve”, an additional curve in the
measurement graph can be removed. A window pops up with a combo
box in which the curve to be deleted can be selected. Note that it is not
possible to delete the curve of the first measurement, as this is the
measurement for which the verdict is given. The selected curve
disappears from the graph on the screen and is removed from the
database such that it does not appear in reports anymore.

Creating a Report

The softkey “Create Report” causes a report to be prepared. The report
preview window (see below) opens and shows the preview of the report.
Buttons in the preview window allow to print the report or to export it to
PDF, WORD, EXCEL or Rich Text format.

Closing the Measurement Window

The softkey “Close” closes the measurement window. The control is
returned to the R&S UPV-K9 main window. All relevant data associated
with the measurement is imported to the results data. A new entry
appears for the measurement as new row on the bottom of the overview
data grid in the main window.
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Notes on Handset Measurements

Applicability of Measurements and Equipment
Depending on the Release

The 3GPP standard is constantly updated according to technical
advances etc. Therefore different versions of the specifications exist in
parallel, the so-called releases. Use the “Release” menu to display
testcases applicable for a certain release. Furthermore, a separate
spreadsheet “TestCaselList 23147.xIs” is provided which lists all tests
and their applicability for the different releases. This test case list also
serves as a reference for the file names used as parameters when
starting a test case remotely.

Sending Frequency Response and Loudness Rating

Sending Frequency Response

The sending frequency response is specified as the transmission ratio
in dB of the voltage at the decoder output to the input noise pressure at
the artificial mouth.

With ear type 3.1 and 3.2 the mobile phone under test is installed in the
LRGP (loudness rating guard-ring position) according to ITU-T P.76,
and the receiver is sealed to the artificial ear. With ear types 3.3 and 3.4
the mobile phone is mounted on the HATS using the handset positioner.
The adjustment angles on the handset positioner are not specified in
the standard but should be noted for later reference.

A test signal with a sound pressure of -4.7 dBPa are created with the
artificial mouth at the MRP (mouth reference point), and the
corresponding output voltage is measured at the R&S CMU200 speech
decoder output and evaluated.

The sending frequency response must be within the limit lines specified
according to table 1 of 3GPP TS 26.131. The absolute sensitivity is not
yet taken into account. The valid limit lines depend on the release of the
specification and are different for narrowband and wideband speech.

The offset of the measured frequency response to the upper or lower limit
line is calculated and then the whole limit template is shifted to be centered
with respect to the measured curve. Then another limit check is performed.
If the shifted curve is now within the limit lines, PASS is output, otherwise
FAIL is displayed. The limit check is performed at each measured
frequency. If the measured value and the end point of a limit line are not at
the same frequency, it may happen that the trace slightly crosses a corner
of the limit line although there are no limit violations. The remaining margin
is displayed. A negative margin shows the amount of limit violation.

Sending Loudness Rating

The sending loudness rating (SLR) takes into account the absolute
loudness in the transmit direction and weights the tones in compliance
with the average speech spectrum and the normal sensitivity of the
average human ear.

To this end, the frequencies (Hz) of bands 4 to 17 (narrowband) or
bands 1 to 20 (wideband), resp., are evaluated according to table 1 of
ITU-T P.79.
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Table 2 Frequencies (Hz) of bands 1 to 20 acc. to table 3 of ITU-T P.79

Band 1 2 3 4 5 6 7

f (Hz) 100 125 160 200 250 315 400
Band 8 9 10 11 12 13 14
f (Hz) 500 630 800 1000 1250 1600 2000
Band 15 16 17 18 19 20

f (Hz) 2500 3150 4000 5000 6300 8000

The sensitivity in dBV/Pa at each frequency is defined as the difference
between the level at the network interface (digital level measured at the
analog R&S CMU200 speech output) and the sound pressure level at
the mouth reference point (MRP), and the sending loudness rating is
calculated according to formula 5-1 of ITU-T P.79. The weighting
factors are taken from ITU-T P.79, table A2 for narrowband and for
wideband according to release 8 and later, and from ITU-T P-79, table
G1 for wideband according to release 6 and 7. Note that loudness rating
values are loss values, i.e. a high loudness rating values indicates a low
gain and a low loudness rating value indicates a high gain.

Due to the input sensitivity tolerance of the R&S CMU200 speech coder,
the individual sensitivity of the R&S CMU200 used has to be taken into
account in order to calculate the sending loudness rating (see
calibration routines). According to 3GPP TS 26.131, the sending
loudness rating should be between 5dB and 11 dB, with lower dB
values corresponding to greater loudness (5 dB = maximum loudness,
11 dB = minimum loudness). The measured SLR is indicated in a
window in the frequency response display and checked for compliance
with these limits. In addition to the numeric value, either PASS or FAIL
is displayed.

The general PASS or FAIL information is obtained from the limit check of
the frequency response curve and the loudness rating. PASS is output only
if both the curve and the loudness value are within tolerances.
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Fig. 37 Sending frequency response with SLR value displayed

Save Curve as
Lirnit File:

Enter

Camment ==

Create Report

Add
Measurement | Delete Curve

1402.0043.12 43 E-6




1402.0043.12

Acoustic Measurements on Mobile Phones

Sending Tests using Artificial Voice according to ITU-T P.50 as
Test Signal

Modulated multisine as test signal is proven to pass GSM and 3GPP
codecs “enhanced full rate” and AMR (adaptive multi-rate) with
12.2 kbit/s without significant degradation. However, most recent
background noise reduction algorithms employ more sophisticated
indicators than just variation over time to distinguish between voice
signals and background noise signals. As a consequence, the spectrum
of the modulated multisine signal may be altered by such algorithms,
which results in a change in the measured frequency response. For this
reason all sending, receiving, sidetone and ambient noise rejection tests
are alternatively offered with artificial voice according to ITU-T P.50 as
test signal, although background noise reduction is mainly employed in
the sending path of mobile phones (update key UPV-K9101 or
UPV-K9102 required).

The test signal simulates the spectrum and time structure of human
voice without having any semantic content. It consists of 10 seconds
“female” voice and 10 seconds “male” voice.

Other than with the modulated multisine, the reference spectra at the
respective inputs of the transmission path are measured in advance
and stored in files. Therefore the speech spectrum calibration for
sending direction is a prerequisite for this test (see chapter 3
“Calibration”).

To make sure that the spectral transform is performed on the same
portion of the test signal during reference spectrum measurement and
output spectrum measurement, the output spectrum measurement is
preceded by a delay measurement employing a sine burst. The start of
the measurement is then delayed against the playback of the test signal
by the measured amount of delay in the transmission path. If the
transmission path is interrupted, e.g. due to a dropped call, the test
stops with a suitable warning message.
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Receiving Frequency Response and Loudness Rating

The following three groups of measurement definitions are available, as
the permissible limit values of the loudness rating depend on the
volume set in the mobile phone under test: “..., nom. Vol” checks
loudness rating limits for nominal loudness setting and at the same time
compliance with the frequency response limit template. “..., max. Vol.”
checks the receiving loudness rating at the highest volume setting
against a minimum. “..., min. Vol.” checks the receiving loudness rating
at the lowest volume setting against a maximum. (Note: As the
loudness rating is a loss value, a high RLR is associated with a soft
speech signal and a low RLR is associated with a loud speech signal).

Receiving Frequency Response

The receiving frequency response is specified as the transmission ratio
in dB of the sound pressure in the artificial ear to the rms value at the
network interface, applied as input voltage at the speech coder input of
the R&S CMU200. The measured sound pressure is either referenced
to the ear reference point (ERP) or (from release 10) to DRP with
diffuse field correction. For ear type 1, the measuring microphone is
directly applied to the ERP and no further correction is required. For ear
types 3.x, the measuring microphone is applied to the drum reference
point (DRP), which is the reason why any measured value has to be
converted to the ERP by means of calibration factors. For special
purpose there are separate measurements supplied with R&S UPV-K91
which measure the sound pressure referenced to the DRP.

The mobile phone under test is installed in the LRGP (ITU-T P.76) or on
the HATS. In case of ear type 1, the receiver is sealed to knife edge of
the artificial ear. In case of ear type 3.2, the receiver is sealed to the
rubber gasket of the artificial ear. If the low leak version of this ear type
is used, care must be taken that the defined leak opening at the
circumference of the artificial ear is not accidentally covered. On the
HATS with artificial ear type 3.3, a certain application force, e.g. 8N has
to be set on the handset fixture.

The speech coder is driven such that a signal with a system reference
level of -16 dBmO is obtained. The sound pressure in the artificial ear is
measured and evaluated.

Ear type 1 will no longer be used for measurements on 3GPP mobile
phones. Therefore, 3GPP TS 26.131 defines limit values only for ear
types 3.x, whereas the limit values specified in 3GPP TS 51.010
(previously GSM 11.10) are still valid for ear type 1.

Use tests “3GPP GSM Rel. 4 Receiving Handset, nom. Vol’, “3GPP
GSM Rel. 4 Receiving Handset, max. Vol’, “3GPP GSM Rel. 4
Receiving Handset, min. Vol” for receiving tests with type 1 artificial ear.
From Release 9 only ear types 3.3 and 3.4 are allowed for standard-
conformal tests. From Release 10 only ear type 3.3 is allowed.
Frequency response limits have been adjusted accordingly. Use the
appropriate versions of the receiving testcase.

When ear type 1 is used, the receiving frequency response must be
within the limit lines specified in table 30.2 of 3GPP TS 51.010. When
ear type 3.x is used, it must be within the limit lines specified in 3GPP
TS 26.131. In the frequency response curve, the limit template is shifted
to be centred with respect to the displayed absolute sensitivity.

The margins of the measured frequency response to the upper and
lower limit lines are calculated separately, and then the whole template
is shifted such that the resulting margins to upper and lower limit are
equal. Then another limit check is performed. If the shifted curve is now
within the limit lines, PASS is output, otherwise FAIL is displayed. The limit
check is performed at each measured frequency. If the measured value and
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the end point of a limit line are not at the same frequency, it may happen
that the trace slightly crosses a corner of the limit line although there are no
limit violations. The remaining margin is displayed. A negative margin shows
the amount of limit violation.

Receiving Loudness Rating

The receiving loudness rating (RLR) takes into account the absolute
loudness in the receive direction and weights the spectral components
in compliance with the difference between an average speech spectrum
and the normal threshold of hearing in quiet of the average human ear.

To this end, the frequencies (Hz) of bands 4 to 17 (narrowband) or
bands 1 to 20 (wideband), resp., are evaluated according to table 1 of
ITU-T P.79 (see table 2)

The sensitivity at each frequency is specified as the ratio dBPa/V,
calculated from the level difference between the level at the network
interface (measured at the analog R&S CMU200 speech decoder
output) and the sound pressure level at the artificial ear, referenced to
the ERP, and the receiving loudness rating is calculated according to
formula 5-1 of ITU-T P.79. The weighting factors are taken from ITU-T
P-79, table A2 for narrowband and for wideband according to release 8,
and from ITU-T P-79, table G1 for wideband according to release 6 and
7.

Due to the output gain tolerance of the R&S CMU200 speech decoder,
the individual sensitivity of the R&S CMU200 used has to be taken into
account in order to calculate the receiving loudness rating (see section
“Calibration” above).

The receiving loudness rating depends on the volume setting on the
mobile phone under test and, according to 3GPP TS 26.131, should be
between -1 dB and +5 dB for narrowband and for wideband according
to release 8 and later, and between 2 dB and 8 dB for wideband
according to release 6 and 7, obtained at a rated (“nominal”) loudness
setting, with lower dB values corresponding to a higher loudness.

The RLR must not fall below -13 dB (-10 dB for wideband in release 6
and 7) when maximum loudness is set on the mobile phone. To prevent
damage to the human ear, the maximum receiving loudness must not
exceed a certain value.

The measured RLR is indicated in a window in the frequency response
display and checked for compliance with these limits. In addition to the
numeric value, either PASS or FAIL is displayed.

With “3GPP Receiving Handset, nom. Vol”, the general PASS or FAIL
information is obtained from the limit check of the frequency response
curve and the loudness rating. PASS is output only if both the curve and
the loudness value are within tolerances.

“3GPP Receiving Handset, max. Vol” checks only the RLR against a
minimum of -13 dB. The frequency response curve is shown for
information only.

“3GPP Receiving Handset, min. Vol” checks the RLR against a
maximum of +18 dB.

46 E-6



1402.0043.12

Acoustic Measurements on Mobile Phones

& 3GPP Receiving Handset, nom. Vol _[o]=

Receiving sensitivity [dB re 1 Palv]

] = [l ]
100 1000 10000
Frequency [Hz]

m Measured, ALR = 3.74 dB . Upper limit . Lowser limit

|36PP Hands Mamow  |Type 3.2 Low Leak ArtEa |CMU / CET |5ample Oibject [

Save Curve as | Load Curve

Fig. 38 Receiving frequency response with RLR value displayed

Save Curve ag
limnit, file

Erter
Comment

(M Delete Curve Create Report Cloze

Receiving Tests using Artificial Voice according to ITU-T P.50 as
Test Signal

Sending, receiving, sidetone and ambient noise rejection tests are
alternatively offered with artificial voice according to ITU-T P.50 as test
signal (update key UPV-K9101 or UPV-K9102 required).

The test signal simulates the spectrum and time structure of human
voice without having any semantic content or language-specific
characteristics. It consists of 10 seconds “female” voice and 10 seconds
“male” voice.

Other than with the modulated multisine, the reference spectra at the
respective inputs of the transmission path are measured in advance
and stored in files. Therefore the respective speech spectrum
calibration narrowband or wideband for receiving direction is a
prerequisite for this test (see chapter 3 “Calibration”).

To make sure that the spectral transform is performed on the same
portion of the test signal during reference spectrum measurement and
output spectrum measurement, the output spectrum measurement is
preceded by a delay measurement employing a sine burst. The start of
the measurement is then delayed against the playback of the test signal
by the measured amount of delay in the transmission path. If the
transmission path is interrupted, e.g. due to a dropped call, the test
stops with a suitable warning message.
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Sidetone Masking Rating (STMR)

The sidetone path is the deliberate output of a part of the signal picked
up by the microphone to the phone's receiver. This is to create a natural
hearing impression for the person speaking on the phone as is
encountered under normal conditions involving an acoustic path
between mouth and ear.

Up to release 7.0 the STMR can only be measured according to
standard using ear type 3.2 (low leakage) (“3GPP STMR, LRGP
Method”). Up to release 4, ear type 1 may alternatively be used for
3GPP TS 51.010 only (“3GPP GSM Rel. 4 Sidetone Masking Rating”).
For these tests the mobile phone under test is installed in the LRGP
(ITU-T P.76), and the receiver is sealed to the artificial ear.

From release 7.1 it is also possible to use ear type 3.3 or 3.4 for this
test. “3GPP STMR, HATS Method, Nom. Vol” has to be passed in the
nominal setting of the user volume control. “3GPP STMR, HATS
Method, All Vol. Steps” has to be passed in all (other) settings of the
volume control. From release 9 either ear type 3.3 or 3.4 has to be
used, from release 10 ear type 3.3 is mandatory.

The artificial mouth generates a test signal with a sound pressure of
-4.7 dBPa at the MRP (mouth reference point), and the sound pressure
is measured in the artificial ear. With ear types 3.2, 3.3 and 3.4, DRP-
ERP correction is applied.

The attenuation of the sidetone path is determined at each frequency
according to table 1 of ITU-T P.79, and the sidetone masking rating
(STMR) is calculated according to formula 5-1 of ITU-T P.79 with the
weighting factors of table 3 of ITU-T P.79 taken into account. In
addition, the gain of the sidetone path is displayed as a curve.

When the phone is set to nominal receiving loudness, the STMR should
be within 13 dB and 23 dB according to 3GPP TS 26.131 when the
LRGP method is applied. With the HATS method, the target STMR is
between 12dB and 20 dB at nominal volume setting. At all other
volume settings, the STMR must not be below 8 dB with the HATS
method.

From version 8.2 and 9.2 of TS 26.131 the target STMR range for the
HATS method has been changed to within 13 and 23 dB. From Version
8.2. and 9.1 of TS 26.132 the weighting factors for unsealed condition of
ITU-T P.79 Table B2 have to be used for the STMR calculation. These
changes are taken into account with the test cases according to “Rel.
8.2+9” and later.
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STMR Tests using Artificial Voice according to ITU-T P.50 as Test
Signal

Sending, receiving, sidetone and ambient noise rejection tests are
alternatively offered with artificial voice according to ITU-T P.50 as test
signal (update key UPV-K9101 or UPV-K9102 required).

The test signal simulates the spectrum and time structure of human
voice without having any semantic content or language-specific
characteristics. It consists of 10 seconds “female” voice and 10 seconds
“male” voice.

Other than with the modulated multisine, the reference spectra at the
respective inputs of the transmission path are measured in advance
and stored in files. Therefore the speech spectrum calibration for
sending direction is a prerequisite for this test (see chapter 3
“Calibration”).

To make sure that the spectral transform is performed on the same
portion of the test signal during reference spectrum measurement and
output spectrum measurement, the output spectrum measurement is
preceded by a delay measurement employing a sine burst. The start of
the measurement is then delayed against the playback of the test signal
by the measured amount of delay in the transmission path. If the
transmission path is interrupted, e.g. due to a dropped call, the test
stops with a suitable warning message.
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Sidetone Delay

The sidetone delay measurement is specified from release 8 of the
3GPP specifications for wideband AMR. Digital signal processing in the
sidetone path can cause a delay of the sidetone, which would result in
an annoying local echo in the handset or headset.

The test according to release 8 and 9 produces a short click in the
artificial mouth and analyzes the amplitude-over-time response at the
artificial ear, starting from the time when the click was produced at the
artificial mouth. The first occurring maximum after approx. 1 ms is
associated with the acoustic propagation from the HATS mouth to the
HATS ear. There may be more maxima during the first milliseconds due
to different propagation paths around the head. The time difference
between the last occurring maximum exceeding a pre-defined level
difference to the noise floor in the observed period, and the first peak, is
defined as sidetone delay. This value must not exceed 10 ms. If no
significant maximum is found before 8 ms from the start of the click at
the artificial mouth, the sidetone delay is defined to be smaller than 8
ms. In the measurement window, “< 8ms” is displayed as result
whereas in the report the value will be simply displayed as “0 ms”.

& 3GPP Sidetone Delay I [=] 3

o
=

40

=
o
=
e
i
w o
<
@&
]
o
&

L U“hs \]\% H i N\ »\ ! N“I)I’M il N "‘\hLﬁ H '41 Mi,l I ]M 'i'f' i m’\ {Wﬂ
W H{MIHH b bkt

0 20 30 40 & 60 70 80 80 100 110 120 130 140 150 160 170 180 190 200
[Dielap [ms]

ful
=

E Measured, Delay < 8 ms

| [H&TS Type 3340 Ear oMU/ CBT | [

Save Curve ag | Load Curve

Fig. 40 Typical sidetone delay result according to release 8 and 9
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From release 10 of 3GPP TS 26.132 the sidetone delay is measured by
cross-correlation between the electric input signal to the artificial mouth
and the electric signal from the artificial ear. The sidetone delay is
defined as difference between first and second maximum of the cross-
correlation envelope.

Test signal is a composite source signal (CSS) according to ITU-T
P.501 which consists of a voiced part and a pseudo-noise multisine
part. Before the test, the test signal is offline-filtered according to the
mouth speaker equalization curve obtained during mouth calibration.
This offline filtering is only performed when the valid speaker
equalization curve is newer than the file with the filtered test signal.
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Echo Loss (TCLw)

The echo loss is the attenuation between the speech coder input and
the speech decoder output (gain of speech coder + decoder = 1).
Normally the echo is caused by internal acoustic coupling between the
telephone receiver and the microphone. Since the echo considerably
reduces the sound transmission quality, it must not exceed a certain
level.

For measurement of echo loss up to release 9 of 3GPP TS 26.132, the
testing shall be made under real use environmental conditions. A typical
“office-type” room should be used. The mobile phone under test is
suspended in free air. From release 10, echo loss is measured with the
handset or headset mounted on the HATS as for most other
measurements.

A modulated multitone signal according to ITU-T P.501 is generated as
a test signal and applied to the speech coder. First, the spectral energy
distribution of the generated signal is measured in the third-octave
bands from 200 Hz to 4 kHz. Then, the spectral distribution in the output
signal of the speech decoder is measured. The echo loss is calculated
from the differences of the bands according to ITU-T G.122. According
to 3GPP TS26.132, the mobile phone under test has to be fed for
approx. 10 s with the male and female version of artificial voice
according to ITU-T P.50 prior to this measurement. This training
sequence is to facilitate optimization for potential echo cancellers. A
quicker test without training sequence is available as “3GPP Echo loss
without training”.

The actual gain of the speech coder and decoder must also be considered
in the result. These values are obtained during codec calibration.

In addition, the attenuation of the echo path is displayed as a curve.

3GPP TS 26.131 specifies an echo loss of at least 46 dB; mobile
phones with good echo cancellers can meet this requirement. Since the
microphone of the mobile phone under test also picks up any side noise
and treats it like an echo, it is essential that the test chamber is well
shielded against external noise.
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Fig. 42 Typical result of echo loss measurement

Stability Margin
The stability margin is measured to test the susceptibility of the phone
to acoustic feedback and instability.

For the test, the telephone is placed on an even, hard board with the
receiver and microphone pointing downwards.

Listen for audible oscillation.
Press softkey corresponding to
your observation.

No Standard [Tyne 3.2 Low Leak At Ea [CMU / CRTU S ample test objzct
CoErglt:énl | Change Scale Create Report Close

Fig. 43 Window during stability margin test
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A loop is closed in the R&S UPV between the receiving and the voice
channel, and an overall gain of 6 dB is set. The gain of the coder is
automatically taken into account (see also Echo Loss).
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To activate the loop, a noise signal of -10 dBmO in line with ITU-T O.131
is applied for 1 s and then switched off, with the loop remaining closed.

The test person has to listen to determine whether any resonances or
oscillations are produced. If there are no oscillations, the minimum
requirements according to 3GPP TS 26.131 for a stability margin of 6
dB are met.

The stability margin test is specified up to release 9 of 3GPP TS 26.132.

Stability Loss

From release 10 of 3GPP TS 26.132, the stability margin test case is
replaced by a stability loss test case. The test measured the attenuation
between input and output of the system simulator, similar to the echo
loss measurement. Other than with the echo loss measurement, the
result is not integrated over frequency, but the spectral minimum is
searched.

The test routine first looks for valid delay results of the selected device
under test in sending and receiving direction. If no results are found, or
if the delay results are older than specified in the parameters of this
measurement, the UE has to be first mounted on the HATS for the
delay measurements.

When valid delay values are available, the mobile has to be set up
according to the following illustration:

min 400 mm /

Clear Area

e

min 500 mm

A

min 400 mm
Clear Area W

Surface min 500 mm

A
v

Fig. 44 Test setup for stability loss test

As soon as the operator has acknowledged the UE to be correctly
placed, a PN signal with high rms level is send to the network interface,
and the returned signal at the output of the system simulator after the
roundtrip delay is measured. The spectral attenuation is calculated from
the difference of the level spectra.
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Fig. 45 Window of stability loss test

A second measurement is performed without test signal to show the
noise “floor” of the measurement. As the graph plots the path loss, the
noise-induced result will usually be above the stability loss result.

Sending Distortion

The SINAD (signal to noise and distortion) ratio in the transmit path is
measured as a function of the sound level.

A pulsed sinusoidal tone with a pulse length of approx. 360 ms is used
for the measurement. For tests according to up to release 8
(narrowband) and up to release 7 (wideband), the frequency of the tone
is 1015 Hz. For measurements according to later releases the
frequency is 1020 Hz (see also table 12 below). At these frequencies,
coding yields a sufficiently stable output signal. Voice activity detection
continues to be active in the mobile phone under test due to this
pulsating signal.

The mobile phone under test is installed in the LRGP or on the HATS.

The test signal is generated with the artificial mouth at the MRP (mouth
reference point) and the SINAD value of the received signal is
measured at the R&S CMU200 decoder output.

The acoustic reference level (ARL) is defined as the sound pressure
which creates a signal level of -10 dBmO in the transmit channel. An
automatic routine varies the sound pressure at the artificial mouth until
the desired level is attained. This value is then used as a reference for
determining the SINAD value versus level.

The SINAD value is measured at sound pressures between -35 dB and
+10 dB relative to the acoustic reference level (ARL) and compared with
the limits specified in table 7 of 26.131 of 3GPP.

Signal processing of a modern mobile phone comprises a voice activity
detector which determines whether a voice signal is present or whether
the sending signal just comprises background noise. With such mobile
phones the sending distortion test according to 3GPP TS 26.132 before
release 6.0.0 may be failed at low levels because the 1 kHz sinewave
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test signal is classified as background noise and suppressed. For this
reason the sending distortion measurement according to release 6.0.0
and onwards omits levels below -25 dB and starts at high test tone
levels gradually reducing the level. For this release, use “3GPP

Distortion sending, Rel. 6”, for earlier releases use “3GPP Distortion
sending, Rel. 4/5”.

The measurement is performed up to a maximum sound pressure of
10 dBPa at the artificial mouth if the value 10 dB relative to ARL with
10 dBPa cannot be attained. The actual trace may therefore end at a lower
pressure. This occurs for mobile phones under test which have a low
sensitivity in the transmit direction.

If the measured trace is above the limit line, PASS is output, otherwise
FAIL is displayed.
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Fig. 46 Sending distortion measurement
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For tests in WB-AMR mode starting from release 8 of 3GPP TS 26.131
and TS 26.132, additional measurements are performed at the
frequencies of 315 Hz, 408 Hz, 510 Hz and 816 Hz with a SPL of -4.7
dBPa at the MRP. Other than in the previous version of the test, the
levels are not defined relative to ARL, but as absolute SPL at the MRP.
A MMS activation signal is issued before each measurement to activate
the VAD (voice activity detector) of the mobile under test. To avoid an
impact of the activation signal on the result due to the processing delay
in the transmission chain, the test routine comprises a delay
measurement. The start of the analysis is delayed against the start of
the test signal by the measured delay time.
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From release 9, version 9.2 of 3GPP TS 26.132, a CSS activation
signal is recommended for test of narrowband and wideband terminals.
Alternatively an activation signal specified by the terminal manufacturer
may be used. Update key UPV-K9101 or UPV-K9102 is required for this
version of the distortion test.

Fig. 48 Recommended activation signal according to version 9.2

The UPV-K9x software provides the CSS activation signal as a default.
However, before first use the signal has to be imported using “Options
- Activation Signal - Import” (see Chapter 2). This step checks the
conditions on the wav file and calculates the active level of the signal.
With the same menu item also other wave files can be imported for use
as activation signal. The wav files must be mono with 48 kHz sampling
frequency and have a duration of 10 seconds or less.

For the sending direction the activation signal must be pre-equalized
according to the inverse frequency response of the artificial mouth. This
can be done during import of the wav file. After a re-calibration of the
artificial mouth, the equalization has become obsolete and has to be re-
done. The macro for the test case automatically detects an obsolete
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equalization of the activation signal and does a new equalization before
the test is started.

If more than one activation signal is imported at the same time, the
signal to be used can be globally chosen with menu item “Options >
Activation Signal - Select”. In addition, the measurement definition for
this test case has a parameter to specify the file name without
extension of the activation signal to be used. If this parameter is
provided, it overrides the global choice of the activation signal. Thus the
test can be repeated several times within a sequence, using different
activation signals.

The test macro for distortion tests with activation signals from wav files
also provides a spectrum display of the signal sent by the mobile. This
is provided for information e.g. for troubleshooting purpose.
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Fig. 49 Spectrum display of the sending distortion test
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During the test, the latest spectrum is displayed. After the test has
finished, button “Show Spectrum” or “Hide Spectrum”, respectively,
toggles between spectrum display and result display. In this state the
spectra to be displayed can be configured in the context menu of the
graph, and the spectra can be exported to ASCII files.

The spectrum display is only available for distortion tests according to
release 9 and later.

Receiving Distortion

The SINAD (signal to noise and distortion) ratio in the receiving path is
measured as a function of the acoustic signal level.

A pulsed sinusoidal tone is used for the measurement. For tests
according to up to release 8 (narrowband) and up to release 7
(wideband), the frequency of the tone is 1015 Hz. For measurements
according to later releases the frequency is 1020 Hz (see also table 12
below). At these frequencies, coding yields a sufficiently stable output
signal.

Voice activity detection continues to be active in the mobile phone under
test due to this pulsating signal.

The mobile phone under test is installed in the LRGP (ITU-T P.76) with
the receiver is sealed to the artificial ear, or on the HATS.
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The test signal is applied to the input of the R&S CMU200 speech
coder, and the SINAD value of the sound pressure in the artificial ear is
measured with psophometric weighting according to ITU-T G.714.

The SINAD value of the sound pressure is measured at levels between
-45 dBm0 and 0 dBmO and compared with the limits given in table 8 of
3GPP TS 26.131.

The measurement is performed up to a maximum sound pressure of
10 dBPa in the artificial ear; the actual trace may end at an earlier point.

If the operator desires to see the receiving distortion value at the point
exceeding 10 dBPa, this can be achieved by pressing the “add
measurement” button. This causes the measurement to be repeated at
all specified levels. The second measurement is not taken into account
for reporting and Pass/Fail decision.

If the measured trace is above the limit line, PASS is output, otherwise
FAIL is displayed.
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Fig. 50 Typical result of receiving distortion measurement

For tests in WB-AMR mode starting from release 8 of 3GPP TS 26.131
and TS 26.132, additional measurements are performed at the
frequencies of 315 Hz, 408 Hz, 510 Hz and 816 Hz with a digital level of
-16 dBmO at the network interface (encoder input). An activation signal
precedes the test signal. To avoid an impact of the activation signal on
the result due to the processing delay in the transmission chain, the test
routine comprises a delay measurement. The start of the analysis is
delayed against the start of the test signal by the measured delay time.
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Fig. 51 Typical result of receiving distortion measurement in wideband
according to release 8.

From release 9, version 9.2 of 3GPP TS 26.132, a CSS activation
signal is recommended for test of narrowband and wideband terminals
(see previous section about sending distortion tests). Alternatively an
activation signal specified by the terminal manufacturer may be used.
Update key UPV-K9101 or UPV-K9102 is required for this version of the
distortion test.
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The UPV-K9x software provides the CSS activation signal as a default.
However, before first use the signal has to be imported using “Options
- Activation Signal - Import” (see Chapter 2). This step checks the
conditions on the wav file and calculates the active level of the signal.
With the same menu item also other wave files can be imported for use
as activation signal. The wav files must be mono with 48 kHz sampling
frequency and have a duration of 10 seconds or less.

If more than one activation signal is imported at the same time, the
signal to be used can be globally chosen with menu item “Options >
Activation Signal = Select”. In addition, the measurement definition for
this test case has a parameter to specify the file name without
extension of the activation signal to be used. If this parameter is
provided, it overrides the global choice of the activation signal. Thus the
test can be repeated several times within a sequence, using different
activation signals.

The test macro for distortion tests with activation signals from wav files
also provides a spectrum display of the signal output at the earpiece of
the mobile. This is provided for information e.g. for troubleshooting
purpose.
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Fig. 52 Spectrum display of the receiving distortion test

During the test, the latest spectrum is displayed. After the test has
finished, button “Show Spectrum” or “Hide Spectrum”, respectively,
toggles between spectrum display and result display. In this state the
spectra to be displayed can be configured in the context menu of the
graph, and the spectra can be exported to ASCII files.

The spectrum display is only available for distortion tests according to
release 9 and later.

Idle Channel Noise Sending

The noise voltage at the speech decoder output is measured with the
phone set up in a quiet environment (< 30 dB(A)).

The mobile phone under test is installed in the LRGP (ITU-T P.76) or on
the HATS.

The decoder output voltage is measured, weighted and recalculated for
the internal level in dBmOp.

For the narrow band test, the weighting is done psophometrically
according to ITU-T G.223. For the wideband version of the test, A
weighting according to IEC 60651 is applied.

To keep the mobile phone under test in the normal operating mode, a
pulsed signal is applied. The noise level is measured during the signal
pauses. The voice activity decoder (VAD) is activated and the mobile
phone remains in the active normal sending mode.

The idle noise level should not exceed -64 dBmOp. The measured noise
voltage is also displayed as a spectrum, making it easier to find causes
if the limit value is exceeded.
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Fig. 53 Typical result of sending noise measurement
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Measurement

The idle channel noise test employs a sinewave activation signal to
activate the sending path of the mobile. To avoid the activation signal
leaking into the measurement, a delay measurement is performed first.
If the signal path is interrupted, e.g. due to a dropped call, the
measurement is aborted with a suitable message.

From release 10 of 3GPP TS 26.132, idle channel noise measurements
also comprise the determination of a spectral maximum to detect
single-frequency disturbances. The spectral maximum is determined
from a 8192 points FFT in a 48 kHz sample rate system. The test
system averages five subsequent measurements, whereby spectral
maxima to be averaged can occur at different frequencies during
averaging. This version of the idle channel noise test requires update
key UPV-K9102.
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Fig. 54 Sending noise measurement according to release 10
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Idle Channel Noise Receiving

The sound pressure in the artificial ear is measured with the phone set
up in a quiet environment.

The mobile phone under test is installed in the LRGP (ITU-T P.76) with
the receiver sealed to the artificial ear, or mounted on the HATS.

The sound pressure in the artificial ear is measured with A-weighting
on.

To keep the mobile phone under test in the normal operating mode, a
pulsed signal is applied to the speech coder input. The noise level is
measured during the signal pauses. The voice activity decoder is
activated and the mobile phone remains in the active normal receiving
mode.

With rated loudness set on the mobile phone, the sound pressure
should not exceed -57 dBPa(A). In this case use test “3GPP Idle
channel noise receiving, nom. Vol”.

At maximum receiving loudness, the sound pressure should not exceed
-54 dBPa(A). In this case use test “3GPP Idle channel noise receiving,
max. Vol”.

The measured noise voltage is also displayed as a spectrum, making it
easier to find causes if the limit value is exceeded.
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Fig. 55 Typical result of receiving noise measurement

The idle channel noise test employs a sinewave activation signal to
activate the sending path of the mobile. To avoid the activation signal
leaking into the measurement, a delay measurement is performed first.
If the signal path is interrupted, e.g. due to a dropped call, the
measurement is aborted with a suitable message.

From release 10 of 3GPP TS 26.132, idle channel noise measurements
also comprise the determination of a spectral maximum to detect
single-frequency disturbances. The spectral maximum is determined
from a 8192 points FFT in a 48 kHz sample rate system. The test
system averages five subsequent measurements, whereby spectral
maxima to be averaged can occur at different frequencies during
averaging. This version of the idle channel noise test requires update
key UPV-K9102.

62 E-6



1402.0043.12

Acoustic Measurements on Mobile Phones

®3EPP Idle channel noise receiving, nom. vol., Rel. 10

Spectrum at Art. Ear [dBFPaf4)]

100 1000
Frequency [Hz]

10000

m Measured 1 m Measured 2 m Measured 3 m Measured 4 m Meazured 5

| HATS Type 334t Ear  |ChU / CBT [01d LUMTS habie [

Save Curve as | Load Curve

Save Curve as
Lirnit File: Create Report

Measurement Cammert

i | Delete Curve

Cloze

Fig. 56  Receiving noise measurement according to release 10

This measurement makes high demands on the sound insulation of the
test chamber and the S/N ratio of the measuring microphone including
preamplifier in the artificial ear. A comparison measurement with the
test mobile phone switched off or without a DUT shows the
measurement reserves of the test equipment. Due to the low inherent
noise of the Audio Analyzer R&S UPV, measurements can be made to
about -80 dBPa(A) at 0 dB microphone gain, and even to lower values
when a higher microphone gain is set.

Ambient Noise Rejection

Ambient noise rejection describes the weighted ratio of voice signal
transmission to transmission of ambient noise. An ANR value >0 dB
means that voice as the useful signal is transmitted more loudly than
any ambient noise. The minimum requirement according to 3GPP TS
26.131 is ANR > 0 dB. A value >= 3 dB is recommended. From version
5.1 (with the exception of wideband measurement according to release
6 and 7), an additional allowance of 3 dB should take measurement
tolerances into account, such that the effective minimum value is -3 dB.

To perform this measurement, a homogeneous noise field for
simulating the noise in the environment has to be generated. This
sound field must be generated by additional loudspeakers and noise
generators. To obtain a sufficiently homogeneous sound field, several
uncorrelated generators and loudspeakers are required. The use of 2 to
8 generators and loudspeakers is common practice. The noise sources
have to generate pink noise (spectral power density ~ 1/f). The
permissible error in the relevant third-octave bands must be smaller
than +3 dB with the frequency response of the loudspeakers used also
being taken into account. Please refer to application note 1GA51,
available on the R&S download web site, for suggestions how to
generate the noise field for the ambient noise rejection test.

The adjustment and testing of the sound field is done as a calibration
process (see section 4 above). With sufficient long-term stability of the
noise generators and loudspeakers it can be used for a number of
subsequent tests. Alignment of the noise field has to be repeated if
anything in the setup of the noise sources (loudspeaker position,
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amplifier gain etc.) is changed. Furthermore it is recommended to check
the noise field in regular intervals.

After the noise field calibration, the artificial mouth and the artificial ear
must be installed again for the actual measurement of ANR. The MRP
must be installed at the same position as the reference microphone had
during the calibration of the noise field.

The mobile phone under test is installed in the LRGP (ITU-T P.76) or on
the HATS (ITU-T P.58). If installed on the LRGP, the receiver is sealed
to the artificial ear.

Set up a call to the R&S CMU200 and set the bit stream to "Handset
Low" (GSM) or the dedicated channel voice to "Speechcodec Low"
(WCDMA).

At first the noise spectrum picked up by the phone and sent on the
uplink is measured. After completion of the measurement, the request
to switch off the noise field will be displayed on the screen. If this is
confirmed, the speech sending sensitivity will be measured
automatically and the ANR value will be calculated afterwards.

The minimum value in the tests named “..., w. 3 dB uncert. allow.” is -
3 dB. In all other ANR tests the minimum requirement is 0 dB.

3GPP Ambient Noise Rejection _[Of=

DELSM [d8]

20 I 1
100 1000 10000
Frequency [Hz]

B, teasured, ANR = 2,06 d&

|36PF Hands Nanow  [Type 3.2 Low Leak ArtEa |CML / CRT |sample Object [

Save Curve ag | Load Curve

Add
easurement

Enter
Camment

Save Curve as
Lirnit File:

| Delete Curve Create Report Cloze

Fig. 57 Typical result of ambient noise rejection measurement

The graph displays the difference of the room noise sensitivity and the
speech sending sensitivity (DELSM) for information.
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ANR Tests using Artificial Voice according to ITU-T P.50 as Test
Signal

Sending, receiving, sidetone and ambient noise rejection tests are
alternatively offered with artificial voice according to ITU-T P.50 as test
signal. This version of the ambient noise rejection test requires update
key UPV-K9101 or UPV-K9102.

The test signal simulates the spectrum and time structure of human
voice without having any semantic content or language-specific
characteristics. It consists of 10 seconds “female” voice and 10 seconds
“male” voice.

Other than with the modulated multisine, the reference spectra at the
respective inputs of the transmission path are measured in advance
and stored in files. Therefore the speech spectrum calibration for
sending direction is a prerequisite for this test (see chapter 3
“Calibration”).

To make sure that the spectral transform is performed on the same
portion of the test signal during reference spectrum measurement and
output spectrum measurement, the output spectrum measurement is
preceded by a delay measurement employing a sine burst. The start of
the measurement is then delayed against the playback of the test signal
by the measured amount of delay in the transmission path. If the
transmission path is interrupted, e.g. due to a dropped call, the test
stops with a suitable warning message.
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Notes on Hands-Free Measurements

General Remarks

The standards 3GPP TS 26.131 and TS 26.132 define requirements
and test specifications for the tests of the acoustic behaviour of the
mobile phone in this mode, but not all details are specified yet.

R&S UPV-K91 3GPP Mobile Phone tests provide test cases for
handheld hands-free and desktop hands-free mode with narrow band
and wideband speech. Test specifications and limits for hands free car
kits are the same as for desk top hands-free terminals.

Hands-free tests with R&S UPV-K91 support the use of either artificial
mouth according to ITU-T P.51 together with a free field measurement
microphone or alternatively the use of a HATS with type 3.3 or 3.4
artificial ear and artificial mouth according to ITU-T P.58.

Test Setup

All tests must be performed in an anechoic room. Background noise
must be less than 24 dBSPL(A). Furthermore the room should be big
enough and its walls should have sufficient absorption to provide nearly
free-field conditions at the hands-free reference point. Not all test boxes
which are appropriate for handset tests can be used for hands free
measurements.

If a free-field microphone with a discrete P. 51 mouth is used, it should
be configured to the Handheld hands-free UE as per Figure 58 for
receiving measurements and Figure 59 for sending measurements. The
measurement instrument should be located at a distance dyr from the
centre of the visual display of the mobile station. The distance dy is
specified by the manufacturer.

Normal vector
from front of phone

| |
Free-field measurement : n
microphone ) e e R e S S i l
|
|
I
|
|
|
|
|
1

dHF

Fig. 58 Configuration of handheld hands-free UE, free-field
microphone for receiving measurements
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Normal vector

Lip ring from front of phone

position
|
I

£

Fig. 59 Configuration of handheld hands-free UE and artificial mouth
according to ITU-T P.51 for sending measurements

If a HATS is used, the measurement can either be performed binaurally
(with two artificial ears and correction of the RLR by 6 dB) or monaural.

The selection of acoustic accessories used for the hands free tests can
be entered in menu item “Options > Hands free settings”.

Hands Free Settings

LRGP ITU-T P.51 and free field
ricraphone

HATS ITU-T P.58 and type 3.3
artificial ear. monaural

HATS ITU-T P.58 and type 3.3
artifizial ear, binaural

HATS ITU-T P.58 and type 3.4
artificial ear. monaural

HATS ITU-T P.58 and type 3.4
artifizial ear, binaural

Generc speaker and free field
microphone

Cancel Ok ,L
e

Fig. 60 Hands free settings
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b s ',
HATS y i
Reference I Normal vector
Point | from front of phone

Fig. 61 Configuration of handheld hands-free UE with HATS

For desk top hands-free it is referred to ITU-T P. 340 (http://www.itu.int)
for the use of free field microphone and discrete P.51 mouth. The
hands free terminal should be placed on a table of approximately 1 m?
with the centre of its front edge 400 mm perpendicularly from the centre
of the front edge of the table. The surface area should not be less than
0.96 m? and its width should not be less than 0.8 m. The front centre of
the measuring microphone or centre of the lip ring, respectively, should
be placed 300 mm above the centre of the front edge of the table with
the axis of the microphone or artificial mouth inclined towards the centre
of the front edge of the hands-free terminal.

For the use of a HATS with both types of hands-free terminals it is
referred to ITU-T P.581. For handheld hands free the setup of ITU-T
P.581 corresponding to “portable hands-free” should be used. For desk
top hands-free, the centre of the lip ring is positioned as described
above, but the axis of the artificial mouth should be horizontal.

Acoustic Calibration for Hands Free Tests

The calibration for the free field microphone or type 3.3 or type 3.4
HATS ear, respectively, is done as described in chapter 4 above.

For binaural measurements, the second artificial ear has to be
calibrated accordingly, using the sub-item “Second Type 3.3 ear” or
“Second type 3.4 ear”, respectively, in “Calibration - Artificial Ear”.
Note that the second artificial ear must be connected to Analyzer input 2
instead of the R&S CMU200 connection.

According to 3GPP TS 26.132, free field equalization has to be taken
into account. Free field data can either be imported as an average table
from the standard or from an individual calibration disk, using the menu
item “Calibration - Free field equalization”.

The calibration of the artificial mouth for hands free tests comprises two
additional steps. After the level has been adjusted and the frequency
response has been equalized at the MRP, the reference microphone
has to be repositioned at the so-called Hands-Free Reference Point
(HFRP or HATSHFRP).

For the mouth according to ITU-T P.51 the HFRP is in 50 cm distance
from the lip ring on the axis of the mouth. The calibration has to be
performed at this point independent of the measuring distance currently
used.
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The HATS HFRP is stipulated in ITU-T P.581. It is one of the points 11
to 17 defined in table 6a of ITU-T P.58. It should be on the axis which is
closest to the actual axis from the lip ring to the microphone under test.
The distance is always 50 cm from the lip ring. The axis may be
azimuthally centric (i.e. 0° horizontally) with an elevation (vertical) angle
of 0°, £15° or +30°. Points 16 and 17 are located on an axis with 0°
elevation and an azimuth angle of 15° or 30°.

The level at this point is adjusted to -28.7 dBPa. For the last step, the
reference microphone is returned to the MRP, and the level and
spectrum at the MRP are measured as reference for the transfer
function calculation.

The mouth calibration for hands-free tests is started with the menu item
“Calibration - Artificial Mouth (Hands Free)”. This procedure comprises
the mouth calibration for handset tests and has also effect on
subsequent handset tests with the same individual artificial mouth.

“Utilites” Measurements

This item of the “Standards” menu contains useful measurements which
are either from other standards or for checking test conditions.

Sidetone Distortion

A sidetone distortion test is specified in 3GPP TS 51.010 30.8 for
measurements using the DAI. As the downlink conveys only silence
during this test, it is, however, more or less independent of the kind of
transmission between system simulator and mobile. The sidetone
distortion test determines 3™ order harmonic distortion at a given set of
frequencies (in the case of TS 51.010 at 315, 500 and 1000 Hz) with a
level of -4.7 dBPa at the MRP. The third order harmonic distortion is
required to be less than 10 % (-20 dB) at all frequencies.

> sidetone Distortion (G5M) 19 [=]
-10

Sidetone Dist. [dB]

-80 1 I !
100 1000 Upper Lim. 10000

Frequency [Hz]
E Measured . Upper limit

|36PF Hands Nanow  [Type 3.2 Low Leak ArtEa |CML / CRT |sample Object [

Save Curve ag | Load Curve

Fig. 62 Sidetone distortion test
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Gain Variation Tests

Gain variation tests in sending and receiving direction are specified in
3GPP TS 43.050 Annex C.5. The limits given in TS 43.050, sections
3.9.1 and 3.9.2 are meant for measurement over DAl and cannot be
fulfiled when a Codec is in the transmission chain. The configurable
versions of the gain variation tests allow to define specific limit curves.

@ sending Gain Yariation, 3GPP _[Of=

10

Sending gain varistion [dB]

20!
50 40 30

E Measured

|36PF Hands Nanow  [Type 3.2 Low Leak ArtEa |CML / CRT |sample Object [
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Fig. 63 Sending gain variation test
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Delay Measurements

Sending and receiving delay can only be measured end-to-end, i.e. from
the acoustic origin of the artificial mouth to the decoder output of the
system simulator or from the encoder input of the system simulator to
the DRP. The measurements offered with R&S UPV-K91 allow to
subtract the estimated delay of the R&S CMU200 from the total
measured value. As the data is interleaved on the air interface, no exact
time instance can be determined when the audio data are transmitted
between mobile phone and system simulator. The values used in the
present measurements are estimations with an uncertainty of about 10
ms. The delay measurement is performed for a given set of
frequencies, and an average is calculated over all frequencies.
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@)Sending Delay CMU =] E3
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Fig. 64 Sending delay measurement
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Measurement

Background Noise Measurements

3GPP TS 26.132 demands the background noise in the test room to be
below -64 dBPa(A) for idle channel noise measurements and below
-30 dBPa(A) for all other handset measurements. For hands free
measurements the background noise needs to be below -70 dBPa. The
background noise measurements offered in R&S UPV-K91 check the
overall noise level against these limits and display the spectrum of the
noise. A lower limit assures that the test is not erroneously passed if no
microphone is connected or the microphone supply is switched off. The
test requires a diffuse field (pressure field) microphone to be connected
to analyzer input 1 and to be placed in the test room, preferably at the
place of the MRP.

@)Backgrnund noise 3GPP, general =] E3
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70
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-90

A-weighted spectrum [dB]

-100

110

I I ] 1
20 100 1000 10000 20000

Frequency [Hz]

B Measured, Noise = -63.0648Pa(A)

|36PP Hands Manow  [Diffuse field microphone  |CMU / CET |5ample Oibject [
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Lirnit File
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Ieasurement
Fig. 65 Background noise measurement
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If the noise in the test room does not fulfil the requirements it may first
be attempted to remove noise sources in the vicinity of the test
chamber. If no further reduction is possible, the sound isolation of the
chamber should be improved. This can be achieved e.g. by heavier
walls. Low frequency noise may possibly be conducted as structure
borne sound, which may be reduced by an isolating support of the
chamber. High frequency noise can be caused by a leakage e.g. at the
door and may be reduced by an improved gasket.
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6 Customizing Measurements

Measurements which implement a test case of a standard are locked
and cannot be edited. However, for each measurement type there is
also a configurable measurement provided, in which the limits can be
customized. The parameters of the measurements are accessible
through the menu item “Config. Meas.”

| Config. Meas, Sequence Report  Options  Help
Configurable Handset ambient Moise Rejection with Modulated mMulkisine
Configurable Handsfree  » Echa loss with modulated mulkisine

R eceiving Handsek with modulated mulkising

ECEiving

- Sidetone Masking Rating with Madulated mMulkising
o Sending with modulated mulkisine

eceiving

Peak Acoustic Pressure Level with Signal "PeakLewvel”
Distarkion receiving

Idle channel noise receiving

Distarkion sending

Idle channel noise sending

Skahbility marain

Sidetone Distartion (genetic)

Sending Gain Yariation

andszet wideband
zending wideband
andset wideband
andszet wideband
andset wideband
andset wideband
zending wideband

ndzet wideband

Receiving Gain Yariakion
Sending Crelay
andset Receiving Delay

_ Background noise measurement (generic)

Fig. 66 Measurement configuration menu

zending wideband
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Clicking on one of the entries opens a window in which all parameters
can be viewed and most of them can be customized:

Parameters of 3GPP Receiving Handset, nom. Yol

Template Files

an File Hame ‘ Type | Upper margin [dE] Lower margin [dB
Description 1 3GPP_Handset_Receiving_  Mandaton up a a
Marrow band meazurement of receiving sensitivity = 2 JGPP_Handset_Receiving_  Mandatory lo 1] 1]

frequency responze and receiving loudness rating
of a handset, using modulated multisine
according to [TU-T P.801. BLR check for
nominal valume setting.

il Mumber [~ 1] DEEE | 2
|DSHD4REDDE 15:08:14 Parameters
Operator instruction Hao| Name | Type | Default Valug Fixed

Set volume contral to nominal position! This test « 1 DRF Boolean False True

must be paszed with at least one arbitrary setting 2 wWideband Boolean false True
of the volume control. 3 ALR upper im. [d8) Diouble 5 True
4 RLR check upper Boalean true True

Program File
RFA_MS
| Mo File name I

1/ 3G receiving response.set

5 FLR lower limit [dB) Double -1 Tue
B RLR check lower EBoolean bz True

MNumber m Eci
Humber 13: = lje ¥ Locked Save copy | Cancel | Ok I

Fig. 67 Measurement parameters window
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As Sequences create copies of the parameter files, each instance of a
measurement in a sequence can have different settings which remain
independent of the setting of this measurement in the main window and
in other sequences. It is for example possible to compile a sequence
with a number of stability margin tests having different loop gain.

The titles of the tests and the messages displayed to the operator
before start of the measurement can also be edited in the “Parameters”
window.

To facilitate copies of test definitions with small adaptations, it is
possible to store a copy of the current parameter set under a different
file name (button “Save copy”). Each measurement definition must have
a unique title to be distinguished from other definitions like for example
the original from which the copy was made.

For the purpose of making adapted copies it is possible to unlock a
standard test definition (uncheck the “Locked” checkbox). In this case
the “ok” button is disabled to avoid unintentional changes in standard
tests.

All newly created test definitions appear in the last sub-menu of the
“Standards” menu” (“More...").

Editing Parameters

Parameters can be edited by entering their number in the “number” field
below the data grid and clicking “Edit”.

Murnber I o

Type
I Crouble j
Default W alue
11
[ Locked
Cancel Ok I
| Y

Fig. 68 Entry window for parameters

Note that the type conformity of the entered value is checked, but not
the value itself against any range limits.

Editing Limit Curves
Clicking “Add” or “Edit” below the data grid for the limit curves opens the
window for selecting limit files.

It is important to know that limit files have to start with the label “UPV
LIMIT FILE” in the first line. They have to be ANSI coded, and the X and
Y values have to be separated by a “TAB” character in each line.

Note that currently “Desired” limit curves are not supported in all test
routines. Most of the measurement allow to specify either lower limits or
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upper limits or both. An exception is formed by the sending response
and receiving response measurements. As the limit template is
centered around the measured curve with these measurements, upper
and lower mandatory limits have to be specified pair-wise.

An existing limit file can be selected using the “browse” button. New
limit files can be created by copying an existing limit file and editing the
copy with a text editor (“Send to - Notepad” in the context menu of the
file in the windows explorer). The number of data points on the curve
must be specified in the “Datacount” line.

Template Curve
Mumber |3
Mandatary upper limit

I andatary lower limit

Desired upper limit
Desired lower limit

Center curve

Upper tolerance  Lower
dB tolerance dB

[ [T

File name Browse |
Cancel | Ok I

Fig. 69 Entry window for selecting limit curves
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7 Measurements with electric connections

1402.0043.12

Introduction

Usually the mobile under test is connected via RF connection to the
R&S CMU200 and via acoustic interfaces (artificial mouth and ear) to
the R&S UPV. Therefore no intrusion in the mobile device is required.

There may, however, be cases during the design process of a mobile
phone where the usual interfaces are not available:

- if a mechanic mockup is to be measured just with the acoustic
components but without the rest of the circuitry

- if a circuit of a mobile phone is to be measured without acoustic
components

- if a hands free kit or headset is to be measured without mobile
phone

- if the hands free or headset connection of a mobile phone is to be
measured without hands free kit or headset, respectively.

In these cases either coder and decoder or artificial ear and artificial
mouth may be replaced by direct electrical connections to the
R&S UPV. To use electric connections, select “Electric connection” in
the respective item of the “Options” menu.

Calibration values for electric connections

Electrical connections cannot be calibrated. Instead a virtual sensitivity
has to be entered for each type of electrical connection under
“Calibration - Electric connections - ...”.

Electric connection replacing artificial ear

R&S UPV Analyzer input 1 is directly connected to the earpiece
amplifier output.

A nominal sensitivity of the receiver (earpiece speaker) for which the
circuit is intended has to be entered in dB re 1 Pa/V.
Electric connection replacing artificial mouth

R&S UPV generator output 1 is directly connected to the microphone
input of the mobile phone circuit.

A nominal sensitivity of the microphone for which the circuit is intended
has to be entered in dB re 1 V/Pa.
Electric connection replacing encoder

R&S UPV generator output 2 is directly connected to a earpiece or
headset speaker or to the speech input of a hands free kit.

A nominal full scale output voltage (output voltage corresponding to
digital full scale) of the circuit intended to drive the speaker or car kit
has to be entered.

Electric connection replacing decoder

R&S UPV analyzer input 2 is directly connected to a microphone or to
the speech output of a hands free kit.

A nominal full scale input voltage (input voltage corresponding to digital
full scale) of the respective microphone or speech input has to be
entered.
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Performing the measurements

After applying the settings in the “Options” menu and after entering
appropriate calibration values for the electric connections in use, the
measurements may be started as usual.

Some parts of the standard require the use of particular artificial ears for
particular measurements. Therefore the checkbox “Allow only selected
measurements” should be unchecked in “Options - Standard”.

For sending tests, the output voltage range in the R&S UPV is set to a
large value in order to be able to drive the speaker of the artificial
mouth. In rare cases sending distortion and/or sending noise results
may be degraded with electric connections if a low microphone
sensitivity is entered. In this case please contact R&S support.
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8 Automatic Test Sequences

s | Sequence Report  Opl

1402.0043.12

Fig. 70 Sequence menu

Creating and Editing a Sequence

The menu item “Sequence > New” first produces a window where a
name for the new sequence has to be entered. Subsequently the
sequence window opens.

@UPV—KQH Mobile Phone Tests {D:43GPP"Results.kml)

File Data Calbration Measurement Standards Config. Meas, Sequence Report  Options  Help
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Fig. 71 Sequence window

Initially the right checked list box is empty. The tree view box on the left
side displays all available measurement definitions structured according
to the standards, similar to their order in the “Standards” menu. A
measurement is appended to the sequence by highlighting it in the tree
view box on the left side and clicking the “Append” button. Subsequently
a measurement, which is highlighted in the checked list box on the right
side, can be moved within the sequence using the buttons “Move up”
and “Move down” and deleted from the sequence with the “Delete X”
button. For non-standard measurements which allow to change
parameters like limit curves, it is possible to edit the parameters before
appending the measurement to the sequence. This is done by clicking
the button “Edit and append”. It is for example possible to assemble a
test sequence which contains stability margin tests with different loop
gains.

A sequence should be run with option “Show operator instructions”
disabled. This avoids interruption of the execution. If a message to the
operator is to be inserted into the sequence on purpose, e.g. “Set user
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volume control to maximum!”, the items provided in the tree view under
“Messages and Control” may be used. Such a message will stop the
execution of the sequence until it is closed by acknowledgement of the
operator.

Remote Control of R&S CMU200 within a Sequence

It is possible to remote control radiocommunication tester R&S CMU200
from the R&S UPV within an automatic test sequence, for example to
wait for a mobile to register, or for originating a call to the mobile. First
the connection interface to the R&S CMU200 has to be set up using
menu item “Options - CMU remote control”. To insert a control
instance into a sequence, choose one of the examples offered in
branch “Messages and Control” of the tree view and edit it if necessary.
For details on the remote control of the R&S CMU200 see the
respective operation manuals.

Each control instance consists of a block of an arbitrary number of
remote commands followed by a status query. The query command
(e.g. “SIGN:STAT?”) and the response to wait for (e.g. “SYNC” or
“CEST”) can be specified as well as a timeout for the case that the
desired response is not received. As the R&S CMUZ200 is organized into
subsystems for the different mobile phone systems / GSM bands, the
subsystem has to be specified as a parameter. Parameter “Auto”
causes the control instance to use the subsystem set with menu item
“Options > CMU Subsystem”. Note that for different GSM bands the
remote commands are usually compatible, but they are not always
compatible between GSM and WCDMA.

In addition, a message to the operator like “Please switch on the
mobile!” can be entered in the “Operator Instruction” field of the
parameter window. Parameter 1 allows to choose whether the message
is shown before or after the block of commands is sent to the
R&S CMU200.

When the R&S CMU200 control instance is executed within a
sequence, a window opens, showing the progress of the control action.

Note: By default, the R&S CMUZ200 changes its state when
switching from local control to remote control or vice versa.
As a consequence, synchronicity / registration or an
established call would be lost during the transition. Therefore
the command “SYSTem:GTRMode:COMPatible OFF” has to
be issued before the first real remote control instance. Insert
“CMU run this first!” in your sequence before any other
remote CMU remote control.
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Fig. 72 CMU remote control window

“Action” shows the current remote control action. “Target state” shows
the desired query response. “CMU Response” shows the actual
response of the R&S CMU200 to the query. Error information returned
from the R&S CMU200 after the last command / query is displayed in
the “Error” field. The “Communication” box lists all commands and
responses issued during the control process. During the status query,
the box “Time left” shows the time left until the timeout expires.

Opening an Existing Sequence
The menu item “Sequence > Open ...” opens a file selector for
specifying the sequence to be loaded. The sequence file is usually
found in a subfolder of D:\3GPP with the same name as the sequence.
The sequence window opens with the specified sequence loaded. The
sequence can then be edited and/or run.

Running a Sequence

When the softkey “Start sequence” is pressed, all checked
measurements in the right list box are executed in sequence. The state
of the checkboxes may be altered by marking a measurement and then
clicking on the checkbox.

A running sequence may be interrupted with one of the buttons in the
measurement control window which is visible while a measurement is
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running. “Cancel and continue sequence” cancels the currently running
measurement and resumes execution of the sequence with the next
measurement. “Cancel and stop sequence” aborts both running
measurement and sequence. “Stop sequence after this measurement”
completes the running measurement and stops the sequence
afterwards.

&

Measuring
Diztartion at -45 dEm0

Cancel and continue zequence

Cancel and ztop sequence

Stop sequence after thiz
meazurement

Fig. 73 Measurement control window

Running a Single Measurement out of a Sequence

A single measurement of a sequence may be started by highlighting the
measurement in the right checked list box and clicking the button “Run
Highlighted”.

Reporting on Sequence Results

A report on all executed measurements of the last run sequence is
prepared and displayed after the “Report Sequence” softkey has been
pressed. After the sequence window has been closed, a report on the
last sequence can be obtained by pressing the “Report last sequence”
softkey in the main window.
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9 Reporting, Storing, Loading and Deleting Results
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Result Files

Measurement results are stored together with all associated data in
XML files. Separate files can be used for different projects or operators.
They can be archived together with other project data and re-opened
later for generating reports.

It is recommended to keep result files small and to generate backups at
frequent intervals.

> UPY-K9x Mobile P

File Data Calibrakion

Open resulks file
Save results
Save results as
Mew resulks File

Load settings
Save setkings
Save settings as

Exit

Fig. 74  File menu

A new (empty) result file can be created with “File > New Result File”
from the main menu.

An existing result file can be opened with “File - Open Result File”
from the main menu.

A currently opened result file can be stored under a new name with “File
-> Store results as” from the main menu.

Report Settings

With “Report - Settings” or “Options - Report settings”, a selection
can be made of data which should appear in the reports. Thus,
information which is the same for a larger number of measurements
does not have to be printed with every report again.

The size of diagrams in the report can be scaled between 100%
(approx. page width) and 50%.

Generating a Single Report

A report on a single measurement result can be generated from the
window of a measurement macro by clicking or pressing the softkey
“Generate report”.

From the result overview of the main window, a report on a single
measurement can be generated by marking the row with the selected
result by clicking on the row header to the left (see Fig. 12), right-
clicking into the data grid and selecting “Generate report” from the
context menu.

Subsequently data associated with the selected measurement is
assembled, a graph for existing curve data is generated, and the
preview window is opened. Depending on the amount of measurement
data, this may take a few seconds.
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Generating a Sequence Report

A report on a sequence of measurements can be generated from the
sequence window by clicking or pressing the softkey “Report
sequence”.

Once the sequence window has been closed, a report on the last
executed sequence can be generated by selecting “Report - Last
sequence” from the main menu. Reports about previous sequences can
be generated as single reports on the measurements of this sequence,
as all results appear in the overview data grid in the main window.

Selection Report

A report on a selection of measurements can be generated from the
results overview data grid in the main window by marking the rows with
the desired results in the “Select” column and choosing item “Report
Selection > Report Selected Results” (see Fig. 11). Rows marked with
XXXXX” in the “Select” column will be added to the report. The
selection can be toggled by clicking into the respective “Select” cells.
Note that another cell must be clicked before the same cell can be
toggled again.

Preview Window

@)Repnrt !Em
& j| y M | 1 A+ fhole Page BusinessObjects:

Main Report |

3GPP Sending Handset widehand

Tl QUMW 155018 e e oy
[

=
\\

Ll

|Current Page Mao.: 1 |Tnta| Page Mo.: 1+ Zoom Factor: Whaole Page

Fig. 75 Report preview window

The main area of the preview window shows a preview of the report as
it will be printed or appear in an exported PDF file. If the report
comprises more than one page, the pages can be browsed using the
buttons

LI
To open the print dialog for installed windows printers click
= |
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To open a file selector for export of the report to PDF, WORD, EXCEL
or Rich Text format, click

The scale of the document in the preview can be adjusted with

Fage Width |«
_ |whole Page T |
o400 |
3003
2003
150% T

5% -

Fig. 76  Scale menu of the preview window

Storing and Loading Curves

Measured curves can be stored from and loaded into the graph of a
measurement macro (see above). This allows easy import into
spreadsheets as well as direct comparison of curves measured at
different times or places. Measured curves can also be stored in a
R&S UPV limit file for use as a limit curve either in a R&S UPV sweep
graph or in the graph of a R&S UPV-K9/K91 window. This allows e.g. to
derive tolerance schemes from “golden devices”. The measured curve
can be arbitrarily shifted before being stored.

Shift Curve by 0= db

Cancel | Ok

4

Fig. 77 Input window for defining a shift of a measured curve for
storage as limit curve

Furthermore curves can be exported from the main results window by
marking the result in the data grid, right-clicking on it and choosing the
item “Save curve of selected row as ...” in the context menu.

ASCII Result Files

When the item “Generate temporary export files” in the “Options” menu
is checked, the standard tests generate “curve.exp” or “abscurve.exp”
and “relcurve.exp” and “result.exp” files similar to those generated by
R&S UPL-B9. These files are always deleted and overwritten by
subsequent tests.

This feature is provided only for compatibility reason. It is not available
in all measurement types.

Deleting Results

It may be desirable to delete results of selected measurements from the
result file, e.g. because the measurement was repeated due to a
missing call to the mobile, a wrong setting etc. To delete the result of a
particular measurement, mark the row for the selected measurement in
the data grid of the main window by clicking on the row header to the
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left, right-click into the data grid and select “Delete result” from the
context menu. After confirmation by the operator, the selected row of
the result overview will be deleted from the result file together with all
associated data.

A set of results may be selected in the “Select” column of the results
data grid and commonly deleted using the context menu item “Report
Selection > Delete Selected Results”.
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10 Remote Controlled Start of Testcases via GPIB

Preparations

- Start the K9x test program on the R&S UPV.

- In the “Options” menu, deactivate item “Show operator instructions”
and activate “Generate temporary export files”.

- If it is desired to download screenshots from the R&S UPV to the host,
activate also “Generate temporary image files” in the Options menu.

- Activate “Enable remote control” in the Options menu

- Do all necessary settings and calibrations as would be done for
manual control.

Starting a Measurement

A measurement can be started with remote command:

SYST:PROG:EXEC
'C:\ControlK9.exe D:\3GPP\3G _rec_handset narrow max.mdf

wherein “ControlK9.exe” is the client program controlling the application
and “D:\3GPP\3G_rec_handset_narrow_max.mdf” specifies a file which
defines the test to be executed. A list of files for various tests is given
separately in the spreadsheed file “TestCaseList 23147.xIs”. The file
name must be separated from the program name by a space character.
Thus it is recognized by the client program as a command line
parameter.

Attention: Do not attempt to control the UPV-K9x software locally
while a remotely started test case is running.

Reading the Results

Result values and curves are available in memory buffers in the
R&S UPV firmware according to the following tables:

Table 3 Assignment of string buffers for result values

String Buffers
1 Title <Tab> Date <Tab> Time
2 Total verdict
3 Result 1 heading
4 Result 1 value
5 Result 1 verdict
6 Result 2 heading
7 Result 2 value
8 Result 2 verdict
9 Margin 1 (upper) heading
10 Margin 1 (upper) value
11 Margin 2 (lower) heading
12 Margin 2 (lower) value
13 Margin 3 heading
14 Margin 3 value
15 Margin 4 heading
16 Margin 4 value
17 Delay heading
18 Delay value

String buffers can be queried using the remote command
SYSTem:MEMory:STRing<i>?
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Table 4 Assignment of trace buffers for result curves

Trace Buffers
1 Result 1 (absolute) curve X values
2 Result 1 (absolute) curve Y values
3 Result 1 shifted / upper limit X values
4 Result 1 shifted / upper limit Y values
5 Result 1 lower limit X values
6 Result 1 lower limit Y values
7 Result 1 relative curve X values
8 Result 1 relative curve Y values
9 Result 2 (absolute) curve X values
10 Result 2 (absolute) curve Y values
11 Result 2 shifted / upper limit X values
12 Result 2 shifted / upper limit Y values
13 Result 2 lower limit X values
14 Result 2 lower limit Y values
15 Result 2 relative curve X values
16 Result 2 relative curve Y values

Trace buffers can be queried using the remote command
SYSTem:MEMory:DATA<i>?

Results are also available in files “D:\3GPP\result.exp”,
“D:\3GPP\relcurv.exp” and / or “D:\3GPP\abscurv.exp”, depending on
the type of measurement. If “Options - Generate temporary image
files” is activated, a screenshot of the last finished test is available in
“‘D:\3GPP\Image.TIF”. The command for the file transfer is (for the
example of the results file)

MMEM:DATA? 'D:\3GPP\result.exp '

All results are stored in the database. However, it is not possible to
change the test object remotely. The results can be identified later by
the test time given in the “result.exp” file.

Determining the Termination of a Measurement

A running test is indicated with bit 13 of the Operation register in the
status system set. It is recommended to configure a service request on
the GPIB for a negative transition of this bit:

STAT:OPER:NTR 8192

STAT:OPER:ENAB 8192

*SRE 128

A service request will be issued as soon as the test has terminated.

To avoid obsolete result files to be downloaded from the R&S UPV,
existing result files can be deleted before the start of the measurement,
using the commands:

MMEM:DEL 'D:\3GPP\result.exp'
MMEM:DEL 'D:\3GPP\relcurv.exp'
MMEM:DEL 'D:\3GPP\abscurv.exp'

Note that an attempt to delete a non-existing file will lead to an entry in
the error queue. The error queue can be flushed using the query
“SYST:ERR?” until the response is ‘0,”"No error”. Alternatively existing
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files can be overwritten by uploading empty files with the same name.
Downloaded files can then be checked for their size before they are
processed further, to determine whether they are empty dummy files.

For further details on remote control of the R&S UPV via GPIB and on
the remote commands mentioned above please see the user manual of
the R&S UPV.
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11 Terminating the Application
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The measurement can be terminated from the main window with the
“Exit” softkey. This causes the result file to be written to the hard disk.

Please allow a few seconds for the results file to be written before
shutting down windows.

Do not shut down the instrument before the application program has
been closed.
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Appendix A Settings on the Radio Communication Tester

R&S CMU200

1402.0043.12

Firmware 4.52

Settings for GSM:

Selection of the GSM band:

. Connect
— GSMsgoo overview |Control
E Menu Select
— Selection |GSM Mohile StatioriSst 800/ Sigrslling/ CverviswP/t Normal GMSK ‘— Hotkeys - Set 1
»BascFunctions > Non-Signaling - aneyzerienerstor ﬁﬁalwer PN
» 3G LMTS User Equipment |* Signaling ~+ Overview |
F AMP'S Mohile Station AUDIO
~ G5 Mobile Station Analyzer/Generator
« GSMA00 —_—
+ 5SM 850 WCDMA UE FDD
Power
|« GSMG00 Maximum
+ GSM 1800 WCDMA UEFDD [l
+ GSM 1900 Modulation
¥ MT-2000 Mot Station WEDMATOveRVIEN
» TDMA Mobile Station AMPS
AnalyzeriGenerator
Modulation
AMPS (5]
Overvie_w
= Modulation

Menu Hotkeys Hotkeys Hotkeys Hotkey
Select Set1 Set 2 Set 3 Assign.

Taking a coupling loss of the antenna coupler into account:

. Connect
GSMQOO Overview |Control

Ch. 2

B GSMooo Connection Control [g Signal On
AF Connector Crverview: RF Connectar Setup
o~ RF 30UT RF 2 RF 1 RF
Analyzer 2 Generator 2
°‘ '° Output
AFIN  AFOUT €] —
Analyzer 1 ° ° Generatar 1 Ext. Att.
e o +00d8+150 48 +0.0 aB Qutput

Speech RF 4 I RF 2 RF 1 RF

Encoder g @_ |nput
Speech Ext. Att.
Decoder +00 a8+ 15048 +0.0 a8 Input

| ﬁwweband
Peak Power

Connection

MS Signal BS Signal | Metwork

AFI’RF@" Sync. |-. z |I
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Select EFR (full rate version 2), HR (half rate version 1), AMR full rate
or AMR half rate speech coder. 3GPP TS26.132 specifies AMR at 12.2
kbit/s which is identical with full rate version 2:

1 GSMo00 Overview

B GSMeoo Connection Control [§

= GSMuooo overview

B GSMooo Connection Control [g

91

Ful Rate Version 2 |¥|

Full Rate Version 1

Full Rate Version 2

Half Rate Version 1
FullRate Data 4800
FullRate Data 9600

Speechcod.fHandset Low |_

Signal On

Full Rate Version 24| |
|G

MCST Test Mode
MCS8 Test Mode
MCS9 Test Mode
AMR Full Rate

AMR Half Rate
Speechcod./Handset Low 4]
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Selection of the Bit Stream Handset Low setting for the measurements
or Decoder Cal and Encoder Cal for the calibration:

= GSMuooo overview ;

B GSMooo Connection Control [g Signal On

Full Rate Version 2| |

Speechcod./Handset Low 4] |
|G

Speechcod./Handset

Speechcod./Handset Low

Codec Cal
Encoder Cal
Decoder Cal

- 62| 947.4 MHz
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Typical setting with EFR speech coder (corresponds to AMR 12.2) for
measurements in the call established status:

= GSMuooo overview ; '_h

B GSMooo Connection Control [& Call Established

Full Rate Version 2 ||l |

Speechcod./Handset Low 4] |

Settings for WB-AMR:
GSMQOO Overview

B GSMooo Connection Control [ Signal On

Full Rate Version 2 |¥| |
[G]

AMR Half Rate GMSK
AMR Half Rate 8PSK

AMR-WB Full Rate GMSK

AMR-WB Full Rate 8PSK

AMR-WB Half Rate 8PSK

Speechcod.Handset Low |4
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Settings for UMTS WCDMA FDD:

Selection of mode:

WCDMA FDD Balnd Modulation t |gg:?::lt

B Menu Select

— Selection |SG UMTS Uzer Equﬁentih\lCDMA FOCySignalina/Modulation/. . . ‘— Hotkeys - Set 1
» Basic Functions » hon-Sigrialing -+ ower RF
. - AnalyzeriGenerator
~ 3G UMTS User Equipment |* Signaling ~+ Moclulstion |
[ - WCDWaFDD | Ao o
F AMP'S Mohile Station AnalyzeriGenerator
¥ SEM Mokile Station —_—
¥ IMT-2000 Mobile Station WCDMA LIE FOD
» TOMA Mobile Station Maximum
WCDMA UE FOD
Modulation
WCDMA Overview
AMPS
Analyzer/Generator
Modulation
AMPS
Overview
Modulation

Eniter]

Menu HotKeys HotKeys HotKeys HotKey
Select Set 1 Set 2 Set 3 Assign,

Setting dedicated channel to voice:

WCDMA Foo Balnd Modulation ﬁ t |gg:?::lt

= WCDMAFDD Connection Control 5 Signal On
RF Chn. Signal
Downing | 21124 mie]| 10562 | Waiting for i |
e UE registration

or
E'Fﬂ::r::l:;n. | 1522.4 MHZ|| 9612| call from the UE.

Ponink
Power

Qutput Ch, Power

330 aBm||  -200 aBm| Voice 1] gﬁd'catfd
Mz all. UE-Pow.  LIL Target Power RMC [« N

Openloop 3 | —
Power

PRACHUE-OnPow.  PRACH Signature Signalling RAB

UE Power
Control

Eniter

Band
Operating Band| |+
Expect PRACH Pow | L g |—| Select

Connection | Handover | UE Signal | BS Signal | Metwork | AFIRFG’l Sync. |.- 2 II

Selection of the Narrowband AMR Speechcodec Low setting and AMR
Bit Rate for the measurements or Decoder Cal and Encoder Cal for the
calibration (selection is possible only if call is deactivated):
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/5] WCDMA Fop *™ Modiation -E gl Conta

B WCDMA oD Connection Control Jg PS: Idle Signal On
—Se‘tup I ircuit Switched™oice Settingsl. .. |’3
Waice Source Spesechcodec Low
Active Coder ME AMR
. ] 3 |
Active Codec Set Selection A Comprese]
Codec Modes 475 khps

O
[ 515 kps
[ s9kops
[ &7 kbps
[ 7akops
[] 7o5kbps |
[ 102kmps
] 122kbps
¥ KB Adaptive Multi Rate (IAB AMR)
~ Signaling RAE Settings

Conneclionl Handover | UE Signal BS Signal | Network | AF!RF@“' Sync. |.- 2 II

3GPP Ts 26.132 specifies 12.2 kbps bit rate for audio testing with the
NB AMR codec.

Selection of the Wideband AMR Speechcodec Low setting and AMR Bit
Rate for the measurements or Decoder Cal and Encoder Cal for the
calibration (selection is possible only if call is deactivated). For the sake
of consistency with Wideband AMR tests in GSM, 3GPP TS 26.132
specifies 12.65 kbps for audio with the WB AMR codec:

@ WCDMA FDD Ea;"d Modulation

Connect
Control

El WCDMA.rop Connection Control [g PS: Icle Cs: Signal On
—Setup [aircuit Switchediveice Settings =
4 RMC Settlngs

o
‘oice Source Speechcodac Low [Comprezz]
Active Coder ME AMR

¥ |ME Adaptive Multi Rate (WB AMR)
Acthve Codec Set Selection &

Codec Modes [ esokops
[ ssskops =
[+] 1285 kbps
[ 1225 kbps
[T 4585 kbps
[ 1825 kbps
[] 1985 kbps
[ 2305 kbps

Connection | Handover UE Signal BS Signal | Network | AF!RFG" Sync. |.- 2 II
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Mobile phone registered status, codec settings possible:

F WCDMA rFop Balnd Modulation ﬁ '_h ’7

= WCDMAFDD Connection Control 5 Registered

| 2112.4 mHz 10562

| 19224 Mz 9612

|

| | Voice[§ |
1]

| - T
£

Operating Band |4 |

= WCDMA rpD Ba:nd Modulation

= WCDMAFDD Connection Control [§

| 2112.4 mHz 10562

| 19224 Mz 9612

|

| | Voice[§ |
1]

| - T
£

Operating Band |4 |

I Bl
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Appendix B Troubleshooting
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Error message 2908 during installation

Please contact customer support.

Damaged setup file is reported

If the program is unable to load the latest setup file, it will automatically
offer to restore a backup of the damaged file. Only if there is no backup
available, or loading of the backup fails again, the following procedure
can be applied:

Copy “Settings.sup” from C:\Program Files\Rohde&Schwarz\UPV-K9x
Mobile Phone Tests” to “D:\3GPP”, overwriting the damaged file of the
same name. Alternatively, “D:\3GPP\settings.sup” may just be deleted.
Subsequently all settings in the “Options” menu have to re-done and for
all used calibration types calibrated devices have to be selected again.

Damaged results file is reported

There are backup files available of the file containing the test results,
with appendix ~1 and ~2 to the file name of the results file (usually
“‘D:\3GPP\Results.xml”). If the results file cannot be opened for some
reason, the program automatically offers to restore the latest backup
file.

If this does not work, a backup file can be renamed by removing the
respective ~1 or ~2 extension, and opened subsequently. It is
recommended to store the damaged results file under a different name.

A test is not starting properly

Re-select devices for the calibration types required for the respective
test, using menu item Calibration > Select device. If this does not solve
the problem, copy all files from “C:\Program
Files\Rohde&Schwarz\UPV-K9x mobile phone tests\3GPP
files\Overwrite” to “D:\3GPP”, overwriting the existing files therein.

A calibration value is missing or no device is selected
for a required calibration type

If re-selecting the calibration device and re-calibrating it does not help,
create a new device with “Calibration = New device”. Tick the
“Immediately select this device” box before clicking the “Ok” button and
do the calibration for this device. All selected devices and their
calibration values can be checked with “Calibration - Show selected
devices”.

The receiving noise test produces an overrange error

Reduce the gain of the conditioning amplifer in the signal path of the
artificial ear, re-calibrate the artificial ear and re-try the test.

97 E-6



1402.0043.12

Acoustic Measurements on Mobile Phones

ARL for the sending distortion test cannot be adjusted

First, try a sending test to see if the connection to the mobile is existing.
If the RLR value is too high, the sending sensitivity of the mobile under
test may be too low to adjust the ARL. If there is no signal in the
sending test (SLR > 60 dB) check the connection between
R&S CMU200 and mobile. If no signal from the artificial mouth is
audible during the sending test, check the signal path between
R&S UPV and artificial mouth. Re-calibrate the artificial mouth.

A measurement using a custom limit curve produces
an error

Limit files must start with a line containing “UPV LIMIT FILE”. They must
be stored as ASCII files with ANSI coding. Any other coding will produce
an error. X and Y values must be separated by a TAB character. Using
space characters instead of a TAB character will produce an error.

Other problems of unknown reason

If the problem cannot be solved with the information given above, the
folder “D:\3GPP” can be renamed or deleted. At the next start of the
application, this folder is created anew with all files in default state.

Attention: Store a backup copy of the results file in a different folder
before deleting “D:\3GPP”.

Note: Subsequently all settings in the Options menu and all data
entries have to be re-done, all calibrated devices have to be
created and calibrated again.
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